INTRO TO COMPUTER

Instructor: Mrs. Annette Roby
Home Phone: 882-2342
Email: annette.roby@k12.sd.us

COURSE DESCRIPTION:

introduction to Computer is a quarter course that satisfies the state's computer lileracy requirement. If will expose the
student to the applications of word processing, database, spreadsheet, web page design, PowerPaint, and deskiop
publishing. In the reaim of the internet, the student will learn how to use a search engine, how to author a web page using
translator software, and discuss the ethics of internet and computer use. The intent of the class is introductory. Each
student will be expected to demonstrate mastery of the outcomes listed in each of the software areas. Assessment will be
in the form of communications oriented, performance based projects.

COURSE OBJECTIVES:

At the completion of this course, each student will demonstrate the following skills:
Identify the parts of a computer

Tum the hardware on and off

Access desired software

Save to a desired iocation

L.oad from a specific location

Print the necessary document
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Students will be able to complete the following functions within the Microsoft Office 2003 Suite:

Word Access Powerfoint
s Create and name a document + Create a database + Create slides
» Place a header / footer » Manipulate a database s Create text boxes
+ Enter fext + Sort a database + Adapt backgrounds
+ Format and edit text + Filter a database +  Apply animation and scund
» Use tables + Query fields to calculate data +  Apply special features
¢ Use mail merge s Create reports + Use slide transitions
+ Spell and grammar check +« Settiming
FrontPage Excel Publisher
» Search for specific data ¢ Create a spreadsheet ¢ Create flyers
¢ Be familiar with HTML » Enterdata +« Create programs
e Use FrontPage to design a » Select and use appropriate « Create certificates using
webpage formulae mail merge
s Create intemal & external ¢ Manipulate data ¢ Create business cards
hyperlinks » Sort and filter data

¢ Change backgrounds

Time permitting; there will possibly be a section on Windows Movie Maker and the integration of movies into PowerPoint.

FINAL PROJECT:

At the end of the quarter, each student, either alone or with a partner, will be expected to choose one of the final project
options available and demonstrate the skills learned in the six units completed throughout the quarter. The project will
require a verbal presentation coinciding with a PowerPoint presentation. This project counts for approximately 10% of
your final grade (it takes the place of a written final—THIS 1S YOUR FINAL TEST). You will be expected to “dress up” for
the final project presentation. Like other units, it will be graded using a rubric you will have in your possession while
working on the project. If you choose to work with a partner please understand that you and your partner wili receive the
same grade for the final when it is completed. And if you CHOOSE not to do the final praject, you will NOT PASS this
class.



GRADING:
TogetaC...
_Each student must demonstrate at least 80% mastery of the skills and concepts of each unit to receive a grade of a C.

TogetaB...
Each student must demonstrate at least 85% mastery of the skills and concepts of each unit and complete two

enrichments to receive a grade of a B.

TogetanA...
Each student must demonstrate at least 92% mastery of the skills and concepts of each unit and complete four
enrichments to receive a grade of an A.

Non-mastery of skills and concepts...
Each student not finished with the assigned skills at the end of the quarter will be given an incomplete and will receive no
credit for class until the work is completed.

My grading policy... GOOD ENOUGH IS NOT GOOD ENOUGH!

CLASSROOM RULES:

Attendance is important and come to class on time.
Follow directions the first time they are given.
Respect the people, equipment, and furnishings of this classroom.
o Your laptop is your life line! If it doesn’t work you don’t work. If you don’t work...
o Abuse to your laptop will most definitely NOT be tolerated!
No pop cans or feod that would normally be eaten at lunch. Bottled drinks and snhacks are allowed. If garbage is
left behind all food and drink privileges will be taken away.
Adjust your voice to suit the activity.
| will inform you on daily laptop use. 95% of the time we will need them promptly when class begins. Be prepared.
! will not tolerate interruptions or wanderlust during a lecture or demonstration!

POSSIBLE CONSEQUENCES FOR VIOLATING RULES:
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Verbal Warning (3rd warning is CRS and/or administrative referral}

Completing an Action Plan to explain how you will comply with the rule in the future
Removal of privileges

After school detention

TARDY ! ATTENDANCE POLICY:
All tardiness will be turned in to the Administration per school policy.

Your attendance is mandatory. This class builds on the previous day'Ss wark. If you are not here for one day it can have
an extremely negative impact on your grade.

CLASSROOM PROCEDURES:
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At the beginning of the block: Be seated in your assigned seat with your binder and laptop ready to go.
Read the plan for the day listed on the black board. Check your email then open the appropriate software.
Always raise your hand if you have a question. My philosophy on questions is; If you have a question, there are
probably three other people who have the same question. ASK IT!
Procedure for using the restroom:

o Ask my permission

o Obtain the classroom pass which is located on the table in the back of the room.
Dismissal at the end of the block: You must throw away any and all trash that you have generated. Put your
binder back on the shelf. You are to remain seated at your table until the bell rings and you are dismissed.

REQUIRED MATERIALS:
COMPUTER, BINDER (SOFTWARE HANDOUTS MANUAL), WRITING INSTRUMENT

CONTACT:
| am always available to assist you. Please e-mail or call (before 10:00 p.m.) me with any problems or concerns,
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Watertown Senior High School
Mrs. Annetie Roby

Introduction to Computer

1 Rules for Success

» Come to class

P Come 1o class on time

» Come to class prepared

P Respect yourself and others
» Respect your computer and classroom
» Course Targets

» Grades

¥ Choose your attitude

Come 1o class

b Attendance is important.
» Planned absence?
® School activity
= Medical appointments
® Efc,
» Unplanned absence?
LB
® Fmergencies

» What to do?




Cometoclassontime

P Be in seat when the tardy bell rings
P Consequence of tardiness
P Class schedules

Come to class preparéd

» Have a pen or pencil with you every day
» Have your binder in front of you

» Always have paper for notes

P Have your computer cut and ready to go

Respect yourself and others =

¥ Be polite—to everyone
» Use please and thaok you
¥ Don’t touch things that don’t belong ta you
¥ Use appropriate® language
* Appropriare languape determined by the

instructor. Just because you hear iton TV
does ot make it appropriate!




Respect your computerand .
classroom = -

b Care of your computer
» Care of the ¢lassroom
» Computer ethics

& whal’s right and

what*s wroang—do you
know?

¥ Food and drink in the
classroom
= Insiructor's diserction

Course Targets

P Microsoft Office
& Word-—word processing
8 Access—dalabase

® PowerPoint—presentation
software

# FrontPage—web page
authering software

® Excel—spreadsheet

= publisher—desktop publishing

® Final Project

Grades

¥ Purpose of'a grade
2 importance of your
(ranscript

Togetal
Togeta B
To getan A

Final Project
a 10% of {inal grade

b Incomplete grades

v v v wv




Choose
Your

Attitude

ttitude is Everything -

Good enough is
NEVER
good enough!

Be the BEST you can be!

P~




Literacy Integration Lesson Plan
Name of Lesson: 4 parts of the computer/read a picture
Teacher: Annette Roby

Class: Intro to Computer

Activate Prior Knowledge
Anticipation guide: Picture of old computer system like I learned on in the 70°s.

Ask students questions about what the picture represents and what they know
about past computer systems and how they are the same as current systems, leading into
how every computer has the same basic four parts.

Set a Purpose for Reading

After explaining the four parts of the computer with the class, while the student
takes notes, they will then understand the information on my website when they go there
to review,

Monrnitor Comprehension
Using double entry journal have students record the 4 parts of the computer and
what each part does.

Organize, Capture, and Remember What Is Read

As a review take students to my school website and go over the 4 parts of the
computer and what each parts does. Answer any questions students may have at this
time. Students may clarify concepts in their notes if they feel it is necessary. Students
have the option of using either the website or their notes to review for the quiz to be taken
the next day.

Reflect and Apply
A quiz will be given on the four parts of the computer.



4 Parts Quiz

Nare

On the table below, fil} in the four parts of any computer. In the columns below the parts, answer the questions you find there.

When you perform this
function, what do you put into
the computer?

Give me an example of this
type of device

What does this part do?

What do you call the language
the computer understands?

When dealing with this part,
what comes out of the
computer?

Give me an example of this
type of device

List one of the
common types of this device.

In the series of concentric
circles on one of these devices,
which circle holds the most
data—the small one in the
middle or the large one on the
outside?




Literacy Integration Lesson Plan
Name of Lesson; Conversation Calendar
Teacher: Annette Roby

Class: Intro to Computer

Activate Prior Knowledge

I will use a sample calendar to explain what I am expecting from the students by
doing the conversation calendar. I will explain how this activity will replace the journal
letter for the week.

Set a Purpose for Reading

The purpose for this activity is to get to know the students better in all aspects of
their lives and to allow them the opportunity to do some free thinking apart from the
computer curriculum. The calendar is worth daily points so it is a way to earn some easy
points as anything they write will be acceptable.

Monitor Comprehension
Students will complete the calendar daily and T will respond daily for one week. 1
will try to do this activity two weeks of each quarter.

Organize, Capture, and Remember What Is Read

Respond daily so the students see value to what is being written. By responding
daily the student will see the teacher is interested in what the student is doing in school
and out of school depending what the student chooses to share.

Reflect and Apply
The calendar will be turned in at the end of the week for poitits.



First and Last Name Block Letter Sample Today’s Date |

Today’s Date “—  Return four times
dafter the dute

Mrs. Roby

Watertown Senior High

Watertown, SD 57201 -« Reﬂfm‘rwo times after
the inside address

Dear Mrs. Roby, 44— Return two times after salutation

Paragraph one introduces the topic of the letter. Notice it is not indented. Likewise, it is
separated from the salutation above by one blank line (two enters). This paragraph must
have a minimum of two sentences but can have more if you wish. You press enter twice
at the end of this paragraph.

Paragraph two is the body of the letter. This paragraph should include your thoughts on
the journal topic assigned for the day. Type as much as you want—it is okay to have a
long paragraph! This paragraph must have a minimum of three sentences. Notice this

" paragraph is not indented and when you are done you should press enter two times.

Paragraph three should include a conclusion to the topic for the day. This paragraph must
have a minimum of two sentences. Wrap up your thoughts in this paragraph. Again, do
not indent and press enter fwice at the end of the paragraph.

Sincerely, < Return four times after the closing

Type your name here



Pretty Good

There once was a pretty good student,
Who sat in a pretty good class

And was taught by a pretty good teacher,
Who always let pretty good pass.

He wasn't terrific at reading,

He wasn't a whiz-bang at math,
But for him, education was leading
Straight down a pretty good path.

He didn't find school too exciting,

But he wanted to do pretty well,

And he did have some trouble with writing,
And nobody had taught him to spell.

When doing arithmetic problems,

Pretty good was regarded as fine.

Five plus five didn't always add up to 10,
A pretty good answer was nine,

The pretty good class that he sat in
Was part of a pretty good school,

And the student was not an exception,
On the contrary, he was the rule,

The pretty good school that he went to
Was there in a pretty good town,

And nobody there seemed to notice
He coutd not teli a verb from a noun.

The pretty good student in fact was

Part of a pretty good mob.

And the first ime he knew what he lacked was
When he looked for a pretty good job,

It was then, when he sought a position,
He discovered that life could be tough,
And he soon had a sneaky suspicion
Pretty good might not be good enaugh,

The pretty good town in our story
Was part of a pretty good state,

Which had pretty good aspiraticns,
And prayed for a pretty good fate.

‘There once was a pretty good nation,
Pretty proud of the greatness it had,
Which tearned much too late,
If you want to be great,
Pretty good is, in fact, pretty bad.
--From "The Osgood File," copyright 1986, CBS Inc.



Intro to Computer ~
Anticipation Guide - Introduction to Software

Directions: Answer the following questions to the best of your ability. You will need to
place a checkmark in the Agree column in you agree with the statement or a checkmark
in the Disagree column if you disagree with the statement,

A gree

Disagree

Statement

The title bar is located at the top of the screen and identifies the
document that is open.

The restore button reduces the application or document window to
an icon.

The menu bar is located below the title bar and displays a list of
icons that are commonly used.

In the menu bar, a checkmark in front of an item would indicate
that it is in use.

The File menu option is used 10 create new documents, open
existing dochments, saving documents, printing, and other related
tasks.

Spelling and grammar features can be found in the Edit menu
option.

Ask a Question is a menu option is used get help on Word topics.

The drawing toolbar and the standard toolbar are the most
commonly vsed toolbars.

The standard toolbar is used to format text such as bold, underline,
bullets, numbering, etc. ..

By pressing Shift and the F1 key you can see a brief description of
a button’s finction.

Toolbars are locked in their default positions on the screen,

The status bar is used to adjust margins, change indents, and set
tabs.

The horizontal scroll bar goes up and down on the screen,

The vertical scroll bar goes up and down on the screen.

The status bar will show what page you are on in a Word document.

A task pane gives you easy access to fundamental tasks in a single
integrated view.







Directions: Now read through pages 1-12 in your binder and then use that information to
formulate an agree/disagree position to each statement.

[ Agree

Disagree

Statement

The title bar is located at the top of the screen and identifies the
document that is open.

The restore buiton reduces the application or document window to
an icon.

The menu bar is located below the title bar and displays a list of
icons that are commoniy used.

In the menu bar, a checkmark in front of an rtem would indicate
that it is in use.

The File meny option is used to create new documents, open
existing documents, saving documents, printing, and other related
tasks.

Spelling and grammar features can be found in the Edit menu
option.

Ask a Question is a menu option is used get help on Word topics.

The drawing toolbar and the standard toolbar are the most
commonly used toolbars.

The standard toolbar is used to format text such as bold, underline,
bullets, numbering, etc. ..

By pressing Shift and the F1 key you can see a brief description of
a button’s fimction.

Toolbars are locked in their default posiitons on the screen.

The status bar is used to adjust margins, change indents, and set
tabs.

The horizontal scrofl bar goes up and down on the screen.

The vertical scroll bar goes up and down on the screen,

The status bar will show what page you are on in a Word document.

A task pane gives you easy access to fundamental tasks in a single
mtegrated view.










Beginning Word Processing Curriculum

Introduction to software
< Terms
% Toolbars

Lesson #1-—Create a document
+» Access the software
++ Save the document
% Create a header/footer
% Enter text
Spell and grammar check
Save and print document

L)
L <

Assessment—Problem #1

Lesson #2—Edit
% Load in an existing document
< Edit the document for style, font, size, alignment, spacing, and color highlighting

Lesson #3—Cut/copy and paste

% Move text from one location to another within the document
% Copy text and place it in a different location within the document

Lesson #4—Rulers
% Set margins (first line indent) and word wraps (hanging indent and right indent)
% Set tabs

Assessment—Problem #4



Title har
Menu bar

Toolbar-

Ruters

Wark area

Task pane

Scroll bars

Status bar

The Word Operating Environment

Word 2002 provides many tools for viewing and manipulating your document.
Word’s operating environment includes these main elements:

+ Tide bar

+  Menu bar

+ Toolbars

*  Ruless

*  Work area
* Task pane

*  Scroll bars

+  Status bar

1 Dozument] - Microsaft Word

¥ @?ﬂldates o iy Wty Stes...
@3 terplates on Moo com

Title Bar

& Document] - Microsoft Word

- The title bar, located at the top of the screen, displays the name of the document

that is currently open and the name of the software program (Microsoft Word).
When you open Word, the blank document that appears is hamed Document]. The
document name in the title bar changes after you save the document and giveita
name. If you open an existing document, that document’s name appears in the title
bar. When you open several documents at the same tlme the title bar helps you
identify each document.



Microsoft Word 2002

The title bar provides the following butions:

Item Name What It Does
Minimize Reduces an application or document window
button to an icon

it Restore Restores a window to its previous size and
button location

Maximize Enlarges the application or document

button window to fill the screen

Close Closes the application or document
button

By clicking and dragging the title bar, you can move a window (when it is not
maximized). By double-clicking the title bar, you maximize the window or restore
it to its previous size and location.

Menu Bar

: ype youw question here ar g

The menu bar is below the title bar. When you click a menu name in the menu b’

a menu opens, displaying a list of commands. Some of the commands have imag.
next to them so you can quickly associate the command with the image. When you
first start Word, the menus and toolbars display basic commands and buttons. As
you work with Word, the commands and buttons that you use most often are

automatically stored as personalized settings and displayed on menus and toolbars.

Word displays short menus and long menus. For example, the following menu
appears when you select the View menu:

]



Getling Started

If you click the arrows at the bottom of the meny, the menu expands to show more
commands:

%

Mormal

‘Web Layout
Print Layout
“Qutline

Task Pane
Toobars *

Ruler

- Document Map

Header and Foote.r'
Footnates

Markup

Full 5_c"reen

Zoom...

You can aiso expand the menu by double-clicking the menu name. When you
expand-one menu, it is expanded until you choose a command or perform another
action. Any command that you click on the expanded menu is added immediately
to the personalized (short) version of the menu. If you stop using a command for a
while, Word stops showing it on the short version of the menu.

Below are some tips to help you use menu items:
* Anellipsis (...) after a command indicates that selecting it opens a dialog box.
* A checkmark (v') in front of a command indicates that the command is in use.

* Anarrow () after a command indicates that more menu options appear when
you select that command.

* Dimmed commands are not available until you select a related item in the
document.

* Shortcut icons appear before the commands that have toolbar icons to launch
the command.

* Shortcut keys after a command show which key combination launches the
command.

To close the menu without selecting a command, click outside the displayed menu.

The menu bar contains nine menus, each of which has a set of interrelated
commands. It also contains the Ask a Question box that returns Help topics that




Wicrosoft Word 2002 .
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answer questions you type in the box. Below is a brief description of each menu
and the commands it contains:

File

Edit

View

Insert

Format

Tools

Creating a new document, opening an existing document, and
closing a document; saving a docuinent; saving a document as a
Web page, searching for files, Web pages, and Outlook items;
versioning a document; Web page preview; page setup, print
preview, printing; sending files through e-mail; viewing file
properties; opening recently used publications; exiting Word

Undoing or repeating last operation; catting, copying, viewing the
contents of the Clipboard, and pasting (pasting special and pasting
as a hyperlink); clearing (deleting) formats and contents {text and
graphics); selecting entire document; finding and replacing text;
using Go To features; checking links; editing and inserting objects

Viewing a document in Normal view, Web Layout, Print Layout,
Outline view; viewing toolbars, rulers, and document map; viewing
headers and footers; viewing footnotes; viewing Markup (displays
or hides comments and tracked changes); viewing full screen and
using zoom control features

Inserting page and section breaks, page numbers, date and time;
inserting Autotext and fields; inserting symbols; inserting
comunents; inserting references (footnotes, captions, cross-
references, and index and ables); inserting Web components;
inserting pictures (e.g., from Clip Art, files, scanner); inserting
charts; inserting diagrams, text boxes, files, objects, bookmarks,
and hyperlinks

Formatting font, paragraph, bullets and numbering, borders and
shading; formatting columns, tabs, drop caps; changing text
direction and changing case; changing background color; applying
a theme; adding frames; using AutoFormat; changing styles and
formatting; revealing formatting (getting, changing, and comparing
formatting information); changing objects

Checking spelling and grammar, setting spelling and language
parameters; using word count and AutoSusitmarize feature; looking
up references; using Speech features; tracking changes; comparing
and merging documents; protecting documents; using online
collaboration features; using letters and mail features (mail merge,
creating envelopes and labels, and using the Letter Wizard); using
Web tools; writing macros; using templates and add-ins; using
AutoCorrect features; customizing your Word environment; setting
options



Getting Started

Table Drawing a table; inserting or deleting tables, rows, columns, or
cells; selecting tables, rows, columns, or cells: merging and
splitting cells, splitting tables; using AutoFormat and AutoFit
teatures; using repeating headers feature; using the convert feature
(table to text or text to table); sorting tables; using formulas in !
tables; hiding or showing table gridlines; displaying table
properties

Window  Viewing a new window; arranging multiple documents; using split
features; switching from document to document windows

Help Using Help features; viewing the Office Assistant: using the What’s
This feature; connecting the Microsoft Office Web site; getting
WordPerfect Help; using Detect and Repair; displaying information
about Word and technical support

Ask a Entering a question and having Word return related topics
Question

Toolbars

Microsoft Word has specialized toolbars with buttons that you can click for
frequently used tasks. These buttons are shortcuts; instead of selecting a command
from a menu, you simply click a button on the toolbar to do the work quickly.

The most commeon toolbars—the standard toolbar and the formatting toolbar—are
displayed when you first start up Word. You can display or hide toolbars
individually (under the View mienu). In this section, you will be introduced to the
the standard and the formatting toolbars.

Note: When a button on a toolbar is grayed out, it is not currently available.

Standard Toolbar
The commands on the standard toolbar are:

Item Used to ...

Create a new blank document
Open an existing dqcument
Save the cuirent document
Send e-mail

Search for files, Web pages, or e-mail items

1-7



Microsoft Word 2002 | '

Used to...

Print one copy of the eatire cutrent document
Print preview
Counduct spelling and gramimar check

Cut selected items from the document and put them in the
Clipboard

Copy selected items from the document and put them in
the Clipboard
Paste the contents of the Clipboard into the document

Copy the formatting of a selection to another location

Undo/Redo the last action

Insert hyperlinks

Display the tables and borders toolbar

Insert table

Insert Microsoft Excel spreadsheet
Format columns

Turn on/off drawing toolbar
Display document map view
Show/hide paragraph marks

Zoom indicator/control

Activate Microsoft Word Help features

[



Gelting Started

Item Used to...

Add/remove buttons

Formatting Toolbar

You may have to add the formatting toolbar if it does not appear on the top of your
screen.

To view the formatting toolbar,

+ Select View : Toolbars : if necessary
Formatting
The formatting toolbar is added.

The formatting toolbar displays buttons used for formatting text. The commands
on this toolbar include:

Item Used to...

Display the Styles and Formatting task pane, where you
can reapply formatting easily, create styles, and select all
text with the same formatting

Display text style of currently selected text; a dropdown
menu contains all the available styles

Display font of currently selected text; a dropdown menu
contains all available fonts

Display font size of currently selected text; a dropdown
menu contains all available sizes for the selected font

Change selected text to bold, italic, and underline

Left align, center, right align, or justify selected text
Changes the spacing between the selécted lines in your
text

Number or bullet text

Decrease or increase paragraph indents
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Item Usedto...

Display the Tables and Borders toolbar

Highlight selected text so it stands out from surrounding
text; a dropdown menu contains all available colors

Change the color of the selected text; a dropdown menu
contains all available colors

Add/remove buttons

Getting Information about a Toolbar Button

Whenever you have a question about a button’s function, point to the toolbar
button with the mouse and Word shows you the name of the button:

If you would like to see a brief description of a button’s function, press the Shift
key and the F1 key. The arrow pointer turns into a question mark pointer. Point t
the button about which you want more information and click. Word displays a boa
describing the button’s function.

For example, if you press the Shift and the F1 keys and position the question mark
over the Print Preview icon, the following box appears:

Print Preview (File menu)
Shows how a file will look when you print it.

Moving Toolbars

You can move toolbars to different locations on your screen. Toolbars can be either
docked (attached to the side of the screen) or floating (not attached).

To move a toolbar,

1. Click and hold the move handie on a docked toolbar (Jocated on the

left side of the toolbar)

-OR-
Click and hold  the title bar on a floating toolbar
2. Drag . the toolbar to a new location



Getting Started

3. Release the mouse button

If you drag the toolbar to any edge of the program window, it snaps into place and
becomes a docked toolbar. If you drag the toolbar away from the edge of the
screen, tt becomes a floating toolbar.

Ruler

.|'...‘..‘l.A.?_.‘.;.‘.3...|...'4<..--|'-"-..5.‘.|..-é

The horizontal ruler, located below the formatﬁng toolbar, atlows you to adjust
margins, change indents, and set tabs. The markers on the ruler show the settings
tor the paragraph that contains the insertion point. '

Status Bar

The status bar, which is located at the bottom of the screen, displays system
information and messages. It includes brief descriptions of the functions of buttons
and highlighted commands; shows page and section numbers; and displays the
position of the insertion point within the document.

The right side of the status bar shows whether various modes, such as REC for
macro recorder or OVR for overtype mode, are turned on. (You can turn a mode on
or off by double-clicking it.) As you type, a book symbol in the status bar shows
the spelling and grammar checking status:

Item What It Does

In the process of checking the document for spelling and
grammar errors

Found an error in spelling and/or grammar

Did not find any errors in spelling and grammar

Scroll Bars

Word has horizontal and vertical scroll bars, which let you view other parts of your
document. (The vertical scroll bar is not shown.) You can move side to side or up
and down in different ways:

* Point to a scroll arrow and click the mouse button.

* Point to the lighter shaded bar and click.

1-11
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. Drag the scroll box up or down (vertical scroll bar) or right or left (horizontal

scroll bar).

The vertical scroll bar also has a Select Browse Object button that opens the Select
Browse Object menu. This menu Iéts you click the item you want to use to browse
through the active file. For example, you can browse by section, page, edits,
graphics, and so on.

Task Pane

Open. a.document:
= Docurents...
New

Di Blank Document -

. @ Blania Web Page

_ @ ankE~mar! Message

M[cmsoftwﬂrd Help :
When activated, the task pane appears on the right side of your screen and gives
you easy access to fundamental tasks in a single integrated view. From the task
pane, you can perform searches, open or start a new document, view the conients
of the Clipboard, format documents and presentations, or even access translation
and template services by using the Web.

To access the task pane,

+ Select View : Task Pane if necessary

Note: The task pane automatically appears when you perform an action that uses
the task pane.



Word Processing—Lesson #1

Lesson #] —Fundamentals

L. Load the Word software and save this document in your home directory (in the class folder)
2. Add an appropiiate header
A, Click on the View menu option and click Header and Footer
B. Click the Insert Auto Text and click the Created by option
L. Note the words Created by and a name appear
2. To replace the name with yours, press the Backspace key once to highlight the
name and type your first and last name
C. Press tab to move to the center of the header and insert the document titie
l. Click the Insert Auto Text and ¢lick the Filename option
2. Since you have saved this document, it should automatically place the document
name you have chosen in the center of the header.
D. Press tab to move to the right of the header and insert the date
1. Click the Insert Auto Text and click the Created On button
2. Check to be sure the date and time are set correctly on the computer and press
the close box
3. Enter the text found between the arrows. Type as quickly and accurately as you can. DO NOT

PRESS THE ENTER KEY AT THE END OF EACH LINE. PRESS IT ONLY AT THE END OF
A PARAGRAPH. AT THE END OF A SENTENCE, PLEASE PRESS THE SPACE BAR
TWICE. Notice that if you spell 2 word differently than the computer thinks it should be spelled,
it will underline it in red. You can go back and correct those spelling errors later. Likewise, if it
questions your grammar, it will underline it in green. For now, just enter the text without
worrying about errors.

) ) 1) ) 1) 1) 1) 1) 1) )

A long time ago, a single software program cost several hundred dollars, worked
differently than any other program on your computer, and stored data in a special file
format that no other program knew how to use. Not surprisingly, many people found
these computer programs frustrating, intimidating, and downright hostile to use.

To make computers easier to use, Microsoft developed a word processor, a spreadsheet
program, a presentational graphics program, a personal information organizer, and a data
base program and grouped them all into a single package called Microsoft Office XP.

Microsoft Office XP will be the basis for the computer class this year. We will word
process, manipulate numbers and data, create presentations, and hopefully organize. The
best is yet to come, so fasten your seatbelts, start your engines, and let’s begm

oI5 ) ) ) 1) ) ) ) )




Even though Microsoft periodically saves your work, you will want to make sure this is done.
Hold the Ctri key down (lower left or lower right key on the keyboard) and press S. This is the
shortcut to save.

Check the spelling, grammar, and spacing
A. Auto-checking
1

1. Look on the screen for words underlined in red. These are the words that don’t
match the dictionary that came with the computer.

2. Place the mouse pointer on the word and RIGHT click on the mouse. It will
give you options for correcting.

a. The possible words the dictionary thinks you want are bolded on the
top. If one of these is correct, simply click on it and it will replace the
incorrect spelling with the corrected spelling.

b. If the word is actually spelled correctly, click the Ignore once buiton.

c. if vou want to add the word to the dictionary (for example, it doesn’t
like the name Roby, but will see it frequently so I would like to add it
to my dictienary), click the Add to-dictionary bution.

When perfect, print the document

A, Save the document
B. Do a print preview to see the document before you actually print a hard copy.
1. Click the print preview tool (paper with magnifying glass) to check the format

of the page—does it have a header—does the header have the correct
information-—does it look like it should?? Always do a print preview before
you print. li saves paper and headaches!

2. Click the close button on the preview window
C. When satisfied the document is perfect, print
1. Click the file menu option and click print

Check to make sure you are printing in Room 304
Say OK

Pick up your printed copy, proofread it for errors, correct as necessary and place
in your binder when done.

& wow



WP-PROBLEM #1

Using the skills you acquired in lesson #1, save a new Word docuruent called Problem #1
in the appropriate location. In the header, place created by and your name on the left, the
filé name in the center, and created on and the correct date and time on the right. Enter
the text found between the arrows. (Text taken from CHICKEN SOUP FOR THE SOUL,
AT WORK by Canfield, Hansen, Rogerson, Rutte, and Clauss.) Check for grammar,
spelling, and spacing errors. Correct as necessary. Print preview to be sure the document
is in correct form. Print and proofread a hard copy.

PLEASE NOTE—

¢ To get the long dash—press the dash key twice and type the next word. When you space after that
word, the computer will automatically join the two dashes into one long dash.

*  The first sentence of the first fizll paragraph will be underlined in green. It is correct as it is
written. Right click anywhere in the sentence and choose the option, Ignore Once.

< . »

An Act of Kindness

{two enters}
Love cures people—both the ones who give it and the ones who receive it. Dr. Karl Menninger
{two enters}

I was being interviewed by a senior manager for a major insurance company. I told him honestly that the
principal reason that [ was interviewing with them was miy need to keep my family in Boston. My wife of
26 years had recently died of a heart attack. A job in Boston would help me reduce some of the extreme
trauma and pain being felt by my {6-year-old daughter. It was important to me to keep her in her present
school.

{two enters}

I could still barely talk about the loss of my wife. Bruce, the interviewer, was politely empathetic, but he
didn’t probe any further. He acknowiedged my loss and, with great respect, moved on to another subject.

{two enters}

After the next round of interviews, Bruce took me to lunch with another manager. Then he asked me to
take a walk with him, He told me that he, too, had lost his wife. And, like me, he had also been married 20
years and had three children. In his sharing, I realized that he had experienced the same pain as I had—g
pain that was almost impossible to explain to someone who had not lost a loved one. He offered his
business card and home phone number and suggested that, should I need help or just want someone to talk
to, I should feel free to give him a call. Whether I got the job or not, he wanted me to know that he was
there if I ever needed help.

{two enters}.

From that one act of kindness, when he had no idea if we would ever see each other again, he helped our
family deal with one of life’s greatest losses. He turned the normally cold business interview process intp
an act of caring and support for another person in a time of extreme need.

{two enters}
Mike Teeley

< 4




Word Processing—Lesson 2

Lesson #2—Editing

1

I. Open the existing document Problem #3 (If not currently on your screen!)

A,

Click the File menu option and click Open

B. Be sure you have Home Directory in the Look In box
C. Find the docament named Problem #1 and click open
2. Rename the document (save it as Lesson 2}
A Click the File menu option and click Save As
B Be sure the Home Directory is active in the Save In box
C. Name the program Lesson #2 in the File Name box
D Click the Save button
3. Reset the header
A. Puil down View to Header/Footer
B Highlight the Filename in the center of the header
C. Click I[nsert Auto Text and click Filename
D Note--as you click, the computer changes the beader appropriately.
4, Format the title
A Highlight the title—"An Act of Kindness”—Click in front of the word An and drag to the
end of the title.
B. Change the Font Size to 18 point
1. On the Formatting Toolbar, click the font size box (to the left of the dark B)
2. Click the 18 point option
C. Center the title
1. Be sure the title is still highlighted
2. Click the second alignment box on the formatting toolbar (2 choices to the right
of the U)
5. Format the Menninger quotation
A, Highlight the quotation but not the author
B. Click the Halicize option on the status line (between the B and the L))
C. Bold the anthor’s name

i Highlight Dr. Karl Menninger
2. Click the Bold option (the dark letter B on the toolbar)



Format the text of the article
A. Highlight the text

i. Click the mouse pointer in front of the beginning of paragraph #1—1 was
I)ei'lg. . .9’
2. Use the scroll bar to move to the botiom of the text but do not include the
author’s name
3. Hold the shift key down and click after . . . extreme need.” The entire body
should be highlighted, ’
B. Set the alignment to Justified (even on both sides)}—click the last alignment option
C. Set the spacing to 1.5
L. Click Format on the toolbar and go to Paragraph
2. Click the Line spacing box arrow and click 1.5
3. Click OK
Color highlight the Menninger quotation
A. Click the highlight option on the status line (the picture of the pen between the box and
the big letter A.)
B. Click and drag across the quotation—don’t include the author

Print Preview, proofread, correct, save, and print the final document, Check your copy against the
correct copy found in the unif materials



Lesson 2 Correct Copy

An Act of Kindness

Love cures people—both the ones who give it and the ones who receive it. Pr. Karl Menninger

I was being interviewed by a senior mavager for a major insurance company. I told him honestly that the
principal reason that [ was interviewing with them was my need to keep my family in Boston. My wife of
26 years had recently died of a heartt attack. A job in Boston would help me reduce some of the extreme
trauma and pain being felt by my 16-year-old daughter. it was important to me to keep her in her present
school.

I could still barely talk about the loss of my wife. Bruce, the interviewer, was politely empathetic, but he
didn’t probe any further. He acknowledged my loss and, with great respect, moved on to another subject.

After the next round of interviews, Bruce took me to lunch with another manager. Then he asked me to
take a walk with him. He told me that he, too, had lost his wife. And, like me, he had also been married 20
years and had three children. In his sharing, I realized that he had experienced the same pain as { had—a
pain that was almost impossible to explain to someone who had not lost a loved one. He offered his
business card and home phone number and suggested that, should I need help or just want someone to talk
to, I should feel free to give him a call. Whether I got the job or not, he wanted me to know that he was
there if T ever needed help.

From that one aci of kindness, when he had no idea if we would ever see each other again, he helped owr
family deal with one of life’s greatest losses. He turned the normally cold business interview process into

an act of caring and support for another person in a time of extreme need.

Mike Teeley



Word Processing—Lesson 3

Lesson #3—Cut/Copy/Paste

I. Load in the document you created in Lesson #1 |

2. Save the document under the new name—ILesson #3—adjust the header as
necessary

3. Change the document using cut and paste and/or copy and paste to resemble the

sample on the next page
A. Highlight the last paragraph

L.
2.

Click the mouse pointer before the words “Microsoft Office™.

Move the mouse pointer to the end of the paragraph, hold the shift
key down, and click

OR (This means do steps 1 and 2, OR step 3, but not all three!)

Click the pointer before the words “Microsoft Office” and drag to
the end of the paragraph

B. Move (cut) the paragraph to the beginning of the document

1.

Place the pointer on the highlighted text and click and hold the left
mouse button down.

Drag the marker to the beginning of the document (just before “A
long time...” ) and release. The text should automatically move to
the beginning of the document

Place your cursor at the end of the paragraph you just moved and
press return once to place a blank line between the first two

paragraphs

OR (This means do steps 1, 2, and 3, OR 4, 5, and 6, not all 6!)
With the text highlighted, cut the text

a. using the Cut option under Edit, or

b. clicking the scissors on the formatting tool bar, or

C. using the keyboard shortcut Control X,

Place the cursor at the beginning of the document (in front of “A
long time...” ) and paste the text

a. using the Paste option under Edit, or

b. clicking the clipboard paste option on the formatting toal
bar, or

c. using the keyboard shortcut Control V



Place your cursor at the end of the paragraph you just moved and
press return once to place a blank line between the first two

paragraphs

C. Copy the part of the text that reads “fasten your seatbelts, start your
engines, and let’s begin.” and paste it at the end of the last paragraph

1.
2,

Highlight the text to be copied

Hold the control key down, click on the highlighted text with the
left mouse button and drag it to the end of the last paragraph.

Be sure there are two spaces between ©. . . Microsoft Office XP.”
and the text you just moved. Also, be sure to change the small “f
on “fasten” to a capital “F”.

OR (This means do steps 1, 2, and 3, OR 4, 5, and 6, not all 6!)
Highlight the text to be copied
a. use the Copy option under Edit, or

b. click the double page (copy option) on the formatting tool
bar, or

C. use the keyboard shortcut Control C
Place the cursor at the end of the last paragraph and paste the text
a, using the Paste option under Edit, or

b. clicking the clipboard paste option on the formatting tool
bar, or

C. using the keyboard shortcut Control V

Be sure there are two spaces between “ . . Microsoft Office XP.”
and the text you just moved. Also, be sure to change the small “f”
on “fasten” to a capital ‘F”. '

4, Save the changes you have made, be sure you have checked the header for
accuracy, and print a copy. Proofread it against the correct copy provided.



Lesson 3 Correct Copy

Microsoft Office XP will be the basis for the computer class this year. We will word
process, manipulate numbers and data, create presentations, and hopefully organize. The
best is yet to come, so fasten your seatbelts, start your engines, and let’s begin,

A long time ago, a single software program cost several hundred dollars, worked
differently than any other program on your computer, and stored data in a special filg
format that no other program knew how to use. Not surprisingly, many people found
these computer programs frustrating, intimidating, and downright hostile to use.

To make computers easier to use, Microsoft developed a word processor, a spreadsheet
program, a presentational graphics program, a personal information organizer, and a data
base program and grouped them all into a single package called Microsoft Office XP.
Fasten your seatbelts, start your engines, and let’s begin.



Word Processing—Lesson #4
Lesson #4-—Rulers

L. Create a new word processing document titled Lesson #4.
2. Add the appropriate header.

3. Key in the text found between the arrows at the end of the instructions. Each time
you see [T], press the tab key once. Each time you see [E}, press the enter key
once. Do not type in the [T} or the {E]. Do not type in {list starts herej. Save.

4, Edit the text in the following manner so that it matches the correct example.
Al Edit the quotation by Penn
i Highlight the quotation (but not the author)

2. Set the left margin and word wrap to 1/2"
a. Click on the rectangle directly betow the two arrows on the
left side of the ruler
b. Drag so that both arrows rest at the %2 marker
3. Set the right word wrap to 57
a. Click on the up arrow at the 6” mark on the right side of the
ruler
b. Drag so that it rests on the 5” mark
4. Format the quotation so that it is 10 point and italic

B. Edit the author’s name
. Highlight William Penn
2. Place a REGHT TAB at the 5” mark on the ruler

a. Immediately to the left of the ruler you will find the tab set
marker (it looks like the letter L. By default, it 1s set to
LEFT TAB. You will want to set it to the RIGHT TAB
setting. To do this, simply click on the tab set marker until
it resembles a backwards L.

b. Place your mouse pointer immediately on the 5”mark on
the ruler and click once—the computer should put the
backwards L in this spot and move the author’s name so the
end of the name lines up at the 5" marker.

3. Format the text so that it is 8 point and bold



C. Edit the list text (All text following LIST STARTS HERE)
1. Highlight the list text
2. Set a LEFT TAB at %4~

a. Change the tab set marker to a left tab (the one that
resembles the letter L)

b. Click at 4" on the ruler

3. Set the left word wrap (the bottom arrow on the left side of the
ruler) so that it is set at 2"

a. Click the bottom left arrow on the ruler and drag to '4”

4, Set the right word wrap (the up arrow on the right side of the ruler)
to 57

5. Spell and grammar check, check for editing accuracy, save and
print. Place in the hand in binder.

< >

If there is any kindness I can show, or any good thing I can do to any fellow being, let me
do it now, and not deter or neglect it, as 1 shall not pass this way again.[E]

[TIWilliam Penn[E][E]

In the book Random Acts of Kindness, produced by the editors of Conari Press, we are
given several suggestions to make life a better place for all of us. Those suggestions
inchude:[E][E]

fLIST STARTS HERE}
[T]Plant a tree in your neighborhood.[E]

[T]The next time someone speaks to you, listen deeply without expecting anything.[E]

[T]Write a note to the boss of someone who has gone out of their way to be pleasant to
you thanking him or her for having such a great employee.[E]

[T]When someone is trying to merge into your lane in traffic, let him in—and why not
smile and wave while doing it!/[E]}

[TJAIl of you reading these words have loved someone, have done someone a kindness,
have healed a wound, have taken on a challenge, have created something beautiful, and
have enjoyed breathing the air of existence. Never doubt how precious, how vitally
important you are. Every moment you make a difference. So, today, appreciate yourself
as a random act of kindness.[E}

< >




Lesson 4 Correct Copy

Ifthere is any kindness [ can show, or any good thing I can do to any Jellow
being, let me do it now, and not deter or neglect it, as I shall not pass this way
agaii.

William Penn

In the book Random Acts of Kindness, produced by the editors of Conari Press, we are
given several suggestions to make life a better place for all of us. Those suggesitons
include:

Plant a tree in your neighborhood.
The next time someone speaks to you, listen deeply without expecting anything.

Write a note to the boss of someone who has gone out of their way to be
pleasant to you thanking him or her for having such a great employee.

When someone is trying to merge into your lane in traffic, let him in—and
why noi smile and wave while doing it?

All of you reading these words have loved someone, have done someone a
kindness, have healed a wound, have taken on a challenge, have created
something beautiful, and have enjoyed breathing the air of existence.
Never doubt how precious, how vitally important you are. Every moment
you make a difference. So, today, appreciate yourself as a random act of
kindness.



WP—Problem #4

Using the skils learned in lessons 1-4, create a new word processing documeent containing the text between
the arrows below. Each time you see [E], press the enter key once. Bach time you see [T], press the tab
key once. Do not type the [E] or the {T]. Be sure (o use an appropriate header. {(lesson 1) Once the text
has been entered, spell and grammar check. (fesson 1) Save and print a copy to be turned in wiih the
edited version. (lesson 1) Edit the text in the following manner:

I Change the Font for the title to anything but Times New Roman. Be sure it is readable and fits on
one line, (lesson 2)

Change the size of the font for the title to 18 point. (lesson 2)

Center the title. (lesson 2)

Highlight the auther’s name and set a right tab at 6”. (lesson 4)

Bold and color highlight the author’s name. (lesson 2)

Highlight the remainder of the text and set a left tab at 14", (lesson 4)

R

Highlight the third paragraph “Think of the Help file. . .” and set the left margin and word wrap
to 17, the right word wrap to 57, and the size of the font to 8 point. (lesson 4)

&=

Justify all the text following the author’s name, (lesson 2)

9. Copy and paste the first paragraph “Microsoft Office 2003 is a big...” so that it is the Iast
paragraph. (lesson 3)

tO. Set the spacing for the new last paragraph to 1 1/2. {lesson 2)

11. Proofread against a correct copy, print and submit both the initial and final drafis.

Getting Help from Microsoft Office 2003{E][E]
[T]Wallace Wang[E][E]

[TIMicroseft Office 2003 is a big program that gobbles up 2 good chunk of your hard disk. One reason the
program is so massive is that it offers more features than you’ll probably ever use in a million years.
Naturally, the best way to get help with Microsoft Office 2003 is to use the book Microsoft Office 2003 for
Windows for Dummies, but the second best way is to use the Microsoft Office 2003 Help file or the Office
Assistant.{E][E]

[T]Essentially, the Help file contains everything printed in the Microsoft Office 2003 manuals. But unlike
the Microsoft Office 2003 manuals, which force you to search page by page yourself, the Help file searches
for topics for you [E][E]

Think of the Help file as an extremely friendly librarian. Just ask the Help file for information on a specific
topic, and the Help file diligently digs through its electronic library and retrieves various snippets of
information that it thinks may be relevant. The Help file presents you with a list of topics, and you can
choose which item you think most likely contains the information you need.[E][E]

{T]A friendlier way to ask for belp is to use the Office Assistant. The Office Assistant is a cartoon
character that appears in a window where you can ask it for help at any time. The information provided by
the Office Assistant is essentially the same information provided by the Microsoft Office 2003 Help file;
the Office Assistant is just easier and more enjoyable to use.

< : >




Getting Felp from Micvasoft Office 2003
Wallace Wang

. Microsoft Office 2003 is a big program that gobbles up a good chunk of your hard
disk. One reason the program is 50 massive is that it offers more features than you’ll
probably ever use in a million years. Naturally, the best way to get help with Microsoft
Office 2003 is to use the book Microsoft Office 2003 for Windows for Dummies, but the
second best way is to use the Microsoft Office 2003 Help file or the Office Assistant.

Essentially, the Help file contains everything printed in the Microsoft Office 2003
manuals. But unlike the Microsoft Office 2003 manuals, which force you to search page
by page yourself, the Help file searches for topics for you.

Think of the Help file as an extremely friendly librarian. Just ask the Help file for
information on a specific fopic, and the Help file diligently digs through its electronic
library and retcieves various snippets of information that it thinks may be relevant. The
Help file presents you with a fist of topics, and you can choose which item you think
most likely contains the information you need.

A friendlier way to ask for help is to use the Office Assistant. The Office Assistant is
a cartoon character that appears in a window where you can ask it for help at any time.
The information provided by the Office Assistant is essentially the same information
provided by the Microsoft Office 2003 Help file; the Office Assistant is just easier and
more enjoyable to use.

Microsoft Office 2003 is a big program that gobbles up a good chunk of your hard
disk. One reason the program is so massive is that it offers more features than you’ll
probably ever use in a million years. Naturally, the best way to get help with Microsoft
Office 2003 is to use the book Microsoft Office 2003 for Windows for Dummies, but the

second best way is to use the Microsoft Office 2003 Help file or the Office Assistant.







Intermediate “Word?” Curriculum

Lesson #l—Add graphics to a documernt

#» How to add clip art

» How to size and place clipart

» How to use the digital camera

» How to access graphics from the WWW

+  dssessment—Problem ]

Lesson #2—Tables

» How to create tables
» How to edit tables

+ Assessment—Problem #2

Lesson #3—>Mail merge

> How to create a mailing list
» How to create a merged letter form
» How to merge

+ Assessment—Problem #3




WP Intermediate Lesson #1-—Graphics

1. Create a new word processing document—with an appropriate header—called
Intermediate Lesson #1. Type in the following text exactly as it appears between
the arows. Te provide spacing between the statements, press the enter key 8
times!

< >

This is a picture taken directly from clip art. When I am finished, it will print with the
graphic fo the right of these words.

This is a picture taken directly from an internet source. When I do this correctly, it will
also appear to the right of these words.

This is a picture of me taken with the digital camera by one of my computer friends.
When I am done with this task my picture will appear to the right of this text. Cute,
aren’t 1?

< »

2. Save the document.
Place a clip art image to the right of the first text line.

A. Place your cursor immediately after the last word in the first line.
Click the INSERT menu option

Click the PICTURE option

‘Click-the CLIPART option

Search for PEOPLE and choose an image from the clipart group that
appears

Adjust the image so that it fits to the right of the first text item and
completely inside the right margin! (see example for guidance)

i Be sure the picture tool bar is active—Click on VIEW and puli
down to TOOLBARS—<heck to see the picture tool bar has a
check mark by it—if it doesn’t, click on it. Now make sure your
graphic is selected. (ust click on it to get the handles to appear)

moaw

™



2. Click the text wrapping option on the toolbar (sheet of paper with
lines through it and picture of a dog in the middle)

3. Choose the TIGHT option and then move the picture so that it
appears to the right of the first text item (see example)

4, Size the picture appropriately (see example)
a. Click on any corner handle and increase/decrease the size
as needed
5. Adjust the picture location to desired point. Check end of lesson

for an example of what it should look like when you are done

Place an internet image to the right of the second text item.

A,

Q@ mmo O

Find the internet site that contains the desired-graphic

1. Open the internet browser—the Explorer icon

2. Go to google.com—click on the Images tab-—search for a blue
dragon

3. Choose a blue dragon from the first three rows of images. Point at

the dragon and right click on it. Choose the Save Picture As
option and save it to your Intro to Computer folder in the Home
Directory. Use the file name blue dragon.

Place your cursor immediately after the last word in the second text item.

Click the INSERT menu optien

Click the PICURE option
Click FROM FILE option
Find the file named blue dragon in your class folder and double click it.

Adjustthe image so that it fits to the right of the second textitem.
(Directions appear above!) Check end of lesson for an example of what
it should look like when you are done

Place your digital camera image to the right of the third text item.

A.

B
C.
D

Pick up a digital camera
Place the disk in the camera
Turn on the cameta

Give the camera o a “friend” (if you don’t have one, make one!) and ask
them to take your picture. (You can return the favor when they need their
picture)

When the picture is taken, turn the camera off and take the disk out of the
camera and place it in the computer disk drive.



F. Click the INSERT menu option and insert the picture repeating the steps
used to place the internet picture in direction #4.. Size the image and place
it in the correct location next to the third text item. Check end of lesson
for an example of what it should look like when you are done

6. Save angd print.

What the exercise should look like!

This is a picture taken directly from clip art. When I am finished, it
will print with the graphic to the right of the text.

This is a picture taken direcily from an internet source. When I do
this correctly, it will also appear to the right of these words.

This is a picture of me taken with the digital camera by one of my
computer friends. When [ am done with this task my picture will
appear to the right of this text. Cute, aren’t I?




WP Intermediate Problem #1

Create a new word processing document called Int. Problem #1. Use an appropriate
header. In this document, write a five sentence story of your life. Include at least one
picture from clp art, one picture from the internet, and one picture from the digital
camera. The graphics must be text wrapped (directions in Int. Lesson 1) and strategicaily
ptaced within the story. Be clever and unique, but remember, you have two more lessons

EXAMPLE:

Many, many years ago, in a small town in

South Dakota, a baby was

The month was November, 3 the day
was number 13, and the year was 1955. She
was the sixth child to enter the family. This

baby began the journey called life, destined

to become a teacher. She
currently “resides in Watertown,
SD and teaches at B the senior high

school.




Create

WP Intermediate Lesson #2—Tables

a new word processing document named Intermediate lesson #2. Place an

appropriate header on the document.
i

Place a 2X7 table on the document

A. Click on the Table menu option

B. Click Insert Table

C. Set the number of columns to 2 and the number of rows to 7. Leave the
column width set to auto
OR

D. Click on the Insert Table icon on the format menu bar (grid lines
without a pencil in them)

E. Highlight 2 boxes across and seven boxes down

F. Enter this choice to create the table on your document

Enter the data found on the next page into the table following the steps listed

below.

A. Click in the first box (referred to as a cell) of the table

B. Key in the word Software and press Tab to move to the cell to the right

C. Key in the word Function and press Tab to move to the next row.
Continue to enter the data (found between the arrows) using the tab
key. NOTE—if you run out of cells, the computer automatically adds
them for you as long as you continue to press the TAB key.

Format the table

A. Highlight the data in the first row (be sure both Software and Function are
highlighted)

B. Click the Table menu option and click on Heading Rows Repeat—while
highlighted, center the data with the alignment buttons

C. Highlight the entire table—(Click on Table in the menu bar, click Select,

then click on Table)

I Click the Table menu option and click on auto fit to auto fit
contents

Place a copy of the table directly below the original—you will have two
identical tables when done with this step

A.

Copy the table
1. Highlight the entire table
2. Copy the table



B. Move to the bottom of (under) the table and press the enter key twice
C. Paste the table
6. Sort the data in_the copy of the table alphabetically A to Z
Click anywhere on the copy of the table
Click the Table menu option
Click Select, then click table
Click the Table menu option again
Click Sort
Sott from A-Z (the computer will call it ascending!) based on column #1
7. Proofread and submit.

< >

Tm oD Ow e

Software Function

Word Processor Turns the computer into a typewriter
Excel Tums the computer into a calculator
PowerPoint Creates a computerized presentation
Publisher Allows for desktop publishing

Access Turns the computer into a filing system
FrontPage Creates web pages

< »



WP Intermediate Problem #2

Using all the skills you now possess, create a word processing document that
informs the employees in your work group that the “boss” has told you the
entire company needs to improve their vocabulary. She has left the choice
of words up to you, but each person in the work group must be able to use
all 15 words by the end of the week. Place a memo at the top of the page
with an appropriate message to the workers. Add a table at the end of the
memo containing 15 words in one column and their definitions in another.
Experiment with the format options found under the Table menu option to
make the document look as good as possible. You will want to auto fit the
contents of the table. You may want to change height and width of cells;
you may want to hide the grid lines. The options are at your disposal. Be
sure you have an appropriate header on the document, then print and submit
for a grade.

Be the Best Good enough is not....

you can be!! GOOD ENOUGH!!!!




WP Intermediate Lesson 3—Mail Merge

Create a new word processing document to use as a merged letter. Name the
document Intermediate Lesson 3.

Prepare the document for data merging (Step 1 of 6)

A Click the Tools Menu item

B Click Letters and Mailings

C. Click the Mail Merge Wizard

D On the Mail Merge task pane that appears, click the Letters option
E Click the Next: Starting document link at the bottom of task pane
Prepare the data to be merged (Step 2 of 6)

A. Click a set up option—in this case—use the current document

B. Click the Next: Select recipients link

C. Create your data source (recipients list) (Step 3 of 6)

1. Notice the task pane prompts you to seiect the recipients for the
letter. Since you do not have a list, click on Type a new list.

2. Click the Create link on the task pane. A New Address List box
appears. Remove fields names not needed by using the customize
option:

a. Click on customize

b. Click on Company Name and click delete. Click yes on
the next window that appears.

Delete Address Line 2 following the same procedure
Delete Country

Delete Work Phone

Delete E-Mail Address and click OK.

3. Input the data {your recipients)

™8 a0

a Type in the first two records of data. Be sure to press the
Tab key to move from one field to the next. Press new
entry when ready to input the second record.

Mrs. Annette Roby
1337 N. Park 5t.
Watertown, SD 57201
§82-2342



-

Mr. Bill Zubke
417 N. Broadway
Watertown, SD 57201
886-8637
b Add your title, name, address, and phone number as record #3.

4. Click the Close button—the computer automatically takes you to
the save window

5. Save the data source as Int. Lesson 3 data (Notice the data is
saved in a folder named My Data Sources on your home
directory——this is okay)

6. You will now see a Mail Merge Recipients list on the screen.
Make sure they are all selected and click OK. This adds your
address list to the task pane and you are ready to move on.

7. Click Next: Write your letter

Compose your merged document (Step 4 of 6)

=
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Click the Insert menu option
Click the Date and Time option
Click the third available format
Click Ok

Press enter four times

To insert an address block (inside address) for the letter, click the Address
block link. You will see the Insert Address Block box——check te set up
the format correctly. (this will depend on how your data source was set up)
The preview window reflects your choices—click OK.

Press enter two times after the Address Block

Insert a greeting—click on the Greeting line link—on the box that appears
check the preview box. It should read Dear Mr. Randall, if so say OK.

Press enter two times
Type in the following text:

This is a sample of the word processor’s ability to take data from one
source and add it to a letter to create a mail merge document, When I
print this letter, one copy will go to each person listed in my data source.
{press enter two times)

Type in Sincerely yours, and press enter four times

Type your first and last name and save this letter.

Click the Next: Preview your lettets link on the task pane. (Step 5 of 6)



A. Check to see that the mail merge worked by clicking the next or previous
buttons on the task pane. (you should have three letters to preview)

When you finish previewing your letters click the Next: Complete the merge link.
(Step 6 of 6)

A. Print the letters
1. Click Print
2 On the Merge to Printer box click All
3. Click OK
4

When the print box appears, check to see where you are printing,
click OK. You will print once but get a copy of the letter
addressed to each person in your data source. You should have
‘three letters.

5. Staple all three letters together with yours on top.



WP Intermediate Problem 3

You’re having a celebration and you want to invite five of your friends to share in the
festivities. Using the information you have learned, create a mail merge document that
meets the following criteria:

1. The invitation is to a party or celebration that is done in good taste according
to your instructor.
2. The data source (recipients list) contains the names and addresses of five of

your friends and your own data as record 6. (remember: name includes first
and last name and address includes city, state, and zip code)

3. The merge document is a creative invitation, including at least one text
wrapped graphic, with information about where, why, when, what, etc,
4. It must be set up in block letter form. (just like the lesson)

Ideas for parties: Birthday, Halloween, KIYI, 4™ of July, Going away party for someone
moving, Christmas, New Years, Valentine’s Day, St. Patrick’s Day, and any other idea
you might have!




Word Processing Assessment

Problem-—As a teacher, you will be taking three of your studenis on a field trip. Create
a mail-merged letter to their parents to inform them of this trip and the materials they
need with them.

Process:

Create a new word processing document with an appropriate header.

Begin with today’s date followed by four enters.

Create a data source with the appropriate fields using the mail merge wizard
option containing the following names:

Mr. and Mrs. R. U. Sieeping Mr. and Mrs. 1. Doncare Ms. Ima Hogg
123 4% 8t. NE 234 59 8t. NE 345 6% St. NE
Watertown, SD 57201 Watertown, 5D 57201 Watertown, SD 57201

Place the inside address in the appropriate location followed by two enters.
The salutation (greeting line) should include the word Dear and the parents’ name
(merged) followed by two enters.

¢ Enter the following text:

Thank you for your continued support!

On Friday, September 22, Watertown Public Schools will be taking a field trip to the
Redlin Art Center. Your child will be a participant in the field trip. We would ask that
your child have the following materials along:

Watertown Public Schools

¢ Print a copy of the unmerged document.

Edit using the following directions:
» Move the “Thank you...” paragraph so it comes at the end of the letter (but before
Watertown Public Schools found at the end of the letter).

» Inserta 2 column 3 row table (think about where this table goes) that places the
words Their books, A pencil, and A clipboard in the left column (one in each
cell) and an appropriate clip art picture for each item in the right column.

Size the pictures so that they are no more than 1” tall.

Format the left column of the table so that the text is 24 point and bold.

Autofit the table

Change the ruler for the first and last paragraph of the letter so that the left margin

is set at ¥ inch and the right word wrap is set to 57,

e Merge and print the 3 letters. Staple the original (unmerged copy) to the top and
hand in all four copies. (YOU WILL HAVE FOUR COPIES WHEN DONE)







WORD PROCESSING ENRICHMENT #1

Digital Camera Picture Story

Skills developed:
Use of the digital camera
Tutegration of digitized data with text

In this enrichment you will use the digital camera. To begin you must get a pass from
your teacher to go out around the school and take the pictures needed for the enrichment.
Using no fewer than four and no more than ten pictures, create a pictorial story about any
aspect of Watertown Senior High School. No picture (except the last one) may appear on
a page by itself. Using MS Word you will insert the pictures and place text with each one
to help tell the story. The last page must contain a full page picture of the author (that’s
you) including your name. As is the case with all assignments in this class, the end result
must be in good taste, A title page is optional (but encouraged).

CREATIVITY IS EXPECTED!!!!




WORD PROCESSING ENRICHMENT #2

Return Address Mailing Labels

Skills developed:
Use of wizards
Creation of mailing labels

In this enrichment, you will use the tools menu option, go to letters and mailings and find
the envelopes and labels option. You will be expected to create return address labels for
at least five different people {(YOU MUST BE ONE OF THE FIVE). Each label must
contain the first and last name of the person, their street address, city, state, and zip code.
The labels must be formatted to fit an Avery standard label 5160 (go to options). Set the
document to print a full page of the same label and click on new document. Repeat the
process for each of the five people. Format the label so it is attractive—this means you
MUST include some sort of editing change on each set of labels to receive credit for this
enrichment. Editing changes include things such as font size, style, color, alignment, etc.
(this can, but does not have to, include graphics) These labels can be printed on label
paper if you plan to use them—let your teacher know and label paper will be provided.

Otherwise print to plain paper. Tumn in all five pages stapled together with YOUR labels

on the top. Staple carefully in the upper left hand comer if label paper was used so as not
to ruin the label.




WORD PROCESSING ENRICHMENT #3

Story or Poem with Graphics

Skills developed:

Integration of graphics and text
Use of text wrapping

Literary attempt

In this enrichment, you will create a word processing document containing at least four
text wrapped graphics strategically placed within the text.

The text needs to:

A. Tell a story, either fiction or non-fiction OR
B. Create a poem
C. Be newly created original work

The end result must be attractively formatted and must be minimally one complete
double-spaced page. You may increase the font size but it must not exceed 18 point.
You may change the font style to your choice. Remember to text wrap the pictures using
the picture toolbar.



WORD PROCESSING ENRICHMENT #4

Technical Writing
¢ Skills developed:
Technical writing
Using outline form
1. Find an internet game that is appropriate for school and learn to play the
game,
2. In MS Word, prepare a set of technical directions for someone to play the

game. Create the direciions so that:

RO T

They are attractive to the eye

They are formatted in an outline form

They are clear to someone who has never seen or played the game
The directions MUST include the internet address for the game
You MUST include a screen print of the game on the document







Word Processing Practice Problem

Problem — You have been asked to help with the Student of the Month awards.
You will need to write a mail merge letter to each student telling them where and
when they will meet for an awards banquet.

Process:
¢ Create a new word processing document with an appropriate header.
¢ Begin with today’s date followed by four enters.
¢ Create a data source with the appropriate fields using the mail merge
wizard opfion containing the following names:

Daffy Duck Minnie Mouse Goofy Dog
111 Funny Street 222 Mouse Ave 333 Dog House
Duckville, IN 11111 Mousetown, SD 22222, Ruffruff, QK 33333

* Place the inside address in the appropriate location followed by two enters.

* The salutation should include the word Dear and the name of the student,
when merged, followed by two enters.

* Enter the following text

Congratulations on being chosen Student of the Month!

We would like fo invite you to a banquet in your honor. Below you will find
the time and location of the banquet. If for some reason you can not attend,
please email me at kranzli@wtn k12.sd.us by Monday.

Linda Kranz

e Print a copy of the unmerged document.

Edit using the following directions:

* Move the “Congratulations. ..” paragraph so it comes at the end of the
letter (but before Linda Kranz found at the end of the letter).

* Insert a 2 column 3 row table (think about where this table goes) that
places the words Time:, Date:, and Location: in the loft column (one in
each cell) and 6:3¢ pm, April 15", and Watertown Senior High Cafeteria
in the right column (be sure you have the information in the correct cells).

¢ [Insert an appropriate clip art image in the paragraph that starts We
would...Monday. Be sure that it is placed in an appropriate spot in the
text so that it looks attractive.

¢ Size the graphic so that it is no more that 1” tall.

Format the left column of the table so that the text is 20 point, Arial font,
and bold.

¢ Autofit the table.

* Change the ruler for the first and last paragraph of the letter so that the left
margin is set at ¥ inch and the right word wrap is set to 5 inches.

* Merge and print the 3 letters. Staple the original copy to the top and hand
in all four copies.






Literacy Integration Lesson Plan
Name of Lesson: Introduction to Access
Teacher: Aunette Roby

Class: Intro to Computer

Activate Prior Knowledge

Using a Prereading Plan I will get discussion started on what they think of when
they hear the word database. I will list all of their thoughts on the computer using the
LCD projector for all students in the class to see. We will reflect on why each
association was made and what it meant. From the discussion I will lead into the Access
unit.

Set a Purpose for Reading

Direct the students to the Access unit materials and have them follow along with
the technical instructions while I demonstrate the seven skills in the unit using my
computer and the L.CD projector.

Monitor Comprehension

While watching the demonstration students will use sticky notes and write
comments or jot down thoughts about concepts that are not clear to them. The notes will
serve as reminders to them of what they want clarification on when I am done
demonstrating. Completion of the skills will show their ability to follow technical
directions.

Organize, Capture, and Remember What Is Read
After completing Access skills 1-7 the students will be expected to complete two
more practice problems using the knowledge they obtained in the opening skills.

Reflect and Apply
The student will turn in the assignments for a grade.






Microsoft Access - o Page 4 |
~ The Soffw_areﬁ

Perhaps no software has increased in use as much as the data base. Microsoft Office uses the..
Access software 1o manipulate data. ‘Its power is amazing, and in this unit, we will simply
introduce you to seven fundamental skills. The format for this unit will be somewhat different.
Instead of lessons and problems, you will have one problem with seven different skills. Each
skill will be described in detail. Each skill will have a printout available so you can check your
progress. If your printout doesn’t match the samplé, something is probably wrong and you will
‘want to ask for assistance. DO NOT ASK FOR HELP WITHOUT BEING ABLE TO
DEMONSTRATE THAT YOU HAVE TREID TO SOLVE THE PROBLEM ON YOUR OWN!
At the end of the problem, you will be asked to complete a practice problem and then perforin an -
assessment demonstrating all seven skills. You may use any and all iotes/directions that you
have. During the assessment, NO questions about “how?”” will be answered:

The Problem

You have recently become a paper cartier for BZAR (pronotiticed biziire) News. You riced fo
find a way to keep track of your customer list. Once you have created the table (skill #1), you
will want to create a form (skill #2) to enter the data. Then, you will want to return to your table;

“sort it (skill #3) alphabetically by last name, keep track of the money each client should be
charged, and how much they have paid (skill #4). To avotd:geiling too far behind in collections,
you will want a quick way to find out who has not paid anything (skill #5). Likewise, you witl
want to be able to calculate how much each clienit-owes and print out only the pertinent
information (skili #6). Finally, for your tax records; you will want to print-out a formatted report
of all your data (skill #7). .

Access Skills to be Mastered

> Create and save a data base
> Create an entry form
> Sott a data base _
» Adjust data base fields (add or subtract as necessary)
> Filter Gields '
»  Query fields to calculate data
> Create Reports
Necessary data to begin
| Customer Name Address Daily? | Sunday?
Abe Zilwiger 123 4" St. | Watertown | SD | 57201 | Yes Yes
Yale Bumblehead | 432 17 St. | Watertown | SD | 57201 | Yes No
Candace | Xerxes 1254 St. | Watertown | SD ] 57201 | No Yes
Walter | Danforth 434 1°' St | Watertown | SD [ 57201 | Yes Yes
Eunice | Verfont 436 I St. | Watertown [ SD | 57201 | No Yes
Ulster Fairmont 438 1" St. | Watertown } SD | 57201 [ Yes Yes
Greta Thonias 126 1" St. | Watertown | SD | 57201 | No Yes
{ Samuel | Hooper 128 1" St. | Watertown § SD | 57201 | Yes Yes
You *You You You You | You Yes Yes




Microsoft Access

Skill #1—Create and save the data base
1. How to load Access |
' A. Click the Access icon (the burgundy key) _
B. Click Blank Database under New on the task pane
C. Name (save) the data'base
1. Save in your class folder in Home Directory
2. If not already highlighted, highlight the contents of the File Name box
3. Name the data base Customers For ()"our.firs_t initial _:‘_i_xﬁ! last name)
4, Click Create - '
2. How to set up the data base

A. Be sure the Tables tab on the top of the window is selected—-click on create
table in Design View :

B. Click New
C. Chick Desngn View on the New Table Window (second optlon down)
D. Click OK
E. Name the fields and type of field
1. Notice the cursor blinking in the first box
2. Type in the field name First Name
3. Press the tab key

4. The computer expects you to tell it what kind of entry this is. The
default setting is Text. Since names are text, simply press tab to
accept the value and move to the deseription

5. The computer then expects a description of the field. First Name is self
descriptive, so that column can be left blank. Press tab to' move 10
the next field name

6. Add the following text fields (with no description) followiﬁg the same
procedure:

Last name
Street
City
State

Zip (even though this is a series of numbers, you will stﬂl enter it
as text!)

7. Add yes/no fields
a, Type in the ficld name Dally" and press tab
b. Click the arrow to the right of the word text

-

by
it



Microsoft Access

¢. Drag down to yes/po and click. Tab to the next ficld name.
d. Type Sunday? and set the same way as Daily?
3. Save the table to your data base
A. Pull down File to Save, type in the name Cuséomer List and click OK.
B. Respond to the Primary Key prompt with NO! '
C. Close the table

Skill #2-—Creating an ei:try form
1. Create a form to enter the data |
A. In the Objects window, click on Forins
B. Choose Create form using Wizard

C. Using the double right arrows, select all the fields you created in the table to be
used in the form document and click Next

D. In the layout window, choose Justified and click Next
E. In the style window, choose Standard and click Next
F. Change the title of the form to Customer List Entry Form and click Finish

G. Using the data on the first page, enter the information on the form. Move from
ficld to ficld by using the tab key. When you get to the yes/no fields, if
the answer to the question is yes, simply press the space bar. If the answer
is no, press the tab key to move to the next field. You will avtomatically
move from one record to the next by pressing the tab key. When you
reach the last record, enter your data. 'When you type in your last name,
make sure you begin with an asterisk and then type your name. (ex. If
Mrs. Roby were doing the exercise, she would enter her last name as
follows: *Roby)

H. Once all data is entered, simply close the form window. Click the Table
tab, open customer list, and notice all the data is now entered in the table.

2. Adjust the field width of each column so that it is as small (with all the data still
readable) as possible
A. Move the mouse 1o the dividing line between field names (it will change
shape!)
B. Double click between the field names—the computer will awtomatically adjust
~ the field width to the best size!

3. Save and print a copy. Compare it to the hard copy sample. I it is correct keep it in
your binder until all skills are finished. 1F IT IS NOT CORRECT, FIX IT!



Microsoft Access

Skill #3—Sorting existing Data
. If not already open, open the data base you created
A. Chick the Access icon

B. Under Open a file, select the database you wish to use—if it is not listed click
on more files.

C. Click on table and choose the one you wish to use—in this case, Customer List
. Sort the data by desired ficld—in this case, Last Name

A. Click the Last Name field name to highlight the column (since we want to
alphabetize by last name!)

B. On the tool bar, find the Sort Ascending button (A to Z with an arrow pointing
down) and click it!

. Save and print a copy. Compare it to the hard copy sample. If it is correct keep it in -

your binder unti] all skills are finished. IF 1T IS NOT CORRECT, FIX IT!
Skill #4—Adding Fields to an existing table

. Be sure the data base and table are open in which ybu will add fields

. Switch to design view to take you back to the window in which you created field -
names (On the toolbar, click View and choose Design)

. Click the first empty field at the bottom of the field name column and add the field you
wish to insert. In this case, you will add the field Weekly Charge.

. Press the tab key and set this field to currency: (DO NOT LEAVE IT AS TEXT)

5. Press the tab key twice to move to the next field name box and set another new field
named Collected. Set this field to curr'e'i;cy too.

. Shlﬁ back to datasheet view. (On the toolbar, (_:lick' View and cheose Datasheet) When
prompted to save, do so!

. Enter the data found on the chart below. It is NOT necessary to put in the dollar signs
or any zeros not followed by another number. The computer will automaticatly
adjust the numbers.

8. Save and priiit a copy. (Because of Customer | Weekly Charge | Collected
the added fields, you will want Zilwiger $5.00 $3.00
to change the page setup to : - .
LANDSCAPE rather than Bumblehead | $3.50 $3.50
portrait before printing?) Yerxes $1.50 $1.50
Compare it to the hard copy
sample. Ifitiscorre¢tkeepitin Danforth $5.00 $3.00
your binder until all skills are Verfont 1$1.50 $1.50
finished. IF IT ISNOT : -
CORRECT, FIX IT! Fairmont . $5.00“ $5 00

| Thomas $5.00 $0.00
Hooper $5.00 $0.00
You = 3$5.00 $0.00




_ Microsoft Access

Skill #5—Flash Filter for specific data

1. ‘Be sure the data base and table, Customer List, are open.

A T

In the table, click in any cell that contains the mformatzon for which you are fooking.
In this particular exercise, you need to find those people who have paid nothmg to
date, so click asiy cell in the field Collected that contatns $0.00.

In the tool bar on top of the page, find the funnel followed by the hghiening'boli.- This

is the flash filter (filter by selection) icon. Click it and your data base shovld
show only those people who have paid nothing to date: This should include you!

Save and print a copy. Compare it to the hard copy sample. If it is correet keep it in
your binder until all skills are finished. IF I'T IS NOT CORRECT, FIX IT!

. Fo remove the filter and retorn to the full data screer, simply click on the funnel icon

(it says remove filter when you point at it) that has nothing else with it. This will
remove the filter you just applied and all names will appear on the table again.

Skill #6—To calculate data

. Close any tables that you have open

Single click on the pame of the table to be used. (Customer List)

It the left window, click Queries

In the queries window, click New

The new query window will come up. Design View will be selected. Click OK

In the Show Table window, highlight the table you want to vse (in this case, Customer
List), click Add and then click close on the Show Table window.

In the Select Query window, double click on the fields you wani to show up on the
report you are creating. (In this case, first name, last name, weekly charge, and
coliected!?) Click them in the order you want them to appear on the report. Be sure
the Show box has a checkmark in it.

When all the fields are selected, press the tab key to move to the next columnn. Type
in the name you want to use as a label (Amount Owed), followed by a colon, and
the math you wish to perform in brackets. For example, if you want the name of
the new field to be Amount Owed and have the query subtract what they have
already paid (Collecied) from a set amount (Weekly Charge), the formula would
be:

Amount Owed:[Weekly Charge]-[Colecied)

Click the Run menu option (ihe red exclamation mark on the tool bar) to see the
results. I it doesn’t work, you have an error and need to retype the formula,
making sure it is perfect (each field name is spelled correctly, the brackets are
correct, and all the mathematical symbols are correct. To get back to the formula,
click on View and pull down to Design View.

10. Save and print a copy. Compare it fo the hard copy sample. If it is correct keep it in

your binder until all skilis are finished. IF IT IS NOT CORRECT, FIX IT!

o



Skill #7—Reporting data

Close the query window. Writing reports can be one of the hardest things to
do in a data base. We are primarily concerned with-using the report wizard
to create our final report. To do this, follow the next three pages step by
step. Save and print a copy. Compare it to the hard copy sample, Ifitis
cotrect, staple it to the first six skills you completed and turn it in. IF IT IS
NOT CORRECT, FIX IT!

PLEASE...staple the seven skills you completed together ih the order you
did them with #2 on the top and #7 on the bottom. Place them in the hand-in

binder. THANK YOU!!




~ "Reporting Data

e In'the Ob;eets window on the far left -
" side of the screcn, Click on the Reports”
choice, lhen chck lhc New“bhtton

'Cboosc thc Report W‘zard option and

click the OK button.
R ks 6o yoms sk o pimer report? On'the Reéport Wizard window; be sire
! You can dhsosc from mono than onc bl or ey you have the Query selected.

|

Mowve ill-the fields to !ImSc!&cted
Fields window by pressing the doi:ﬁle
right ar[ows Press Next to contime.

For this particular report, e don’t
need any grouping, so press lhc Next
button.

R SLE EEY I Carvord | < Gk, Hod > Fnbh l

Creating a Data Base Report o Page 1 O‘:.l

G



EoTWiZd'E )
Wmm&mmhmmdﬂ‘

For the: purpqsc oftlus repon, we

_—_—:“—%_:h mmmmm“m want the recotds displayed.
T | g alphabetically by last name, so' in.
i AL z_‘;- SR =1 1} . blank i1 chckthedbwn‘aﬂow,.
3§ EE : 3 TR _ a immediately to the left o€ the’ AioZ.
JRERTE B e I g = button and choose Last mmi‘:—-—ér, .
i AT e i i simply type in the letter L and let the
oot computer fill in the blank. -~
| /Press the Next button.
Ll I“ ]
Set the Layour to Columviar -~

| Eigheea
€ pawides
© aotificd

o pac

Orlord. sk “I
:a(-“ma

;r N 41——Be sure the orientation s $e£ 10,

P ' Portrait.
:oa)
LN

Check 1o be sure the Adjuss field

: r———— Widih button is selected -

F Adyrst the Feld yidtdh 5. of Febds & on

/Ciick the Next button.

oo [T o |

ecord Wirard -

What syl wrould you e

D JCompat
Corpotate
Formal

Sl G oy

g Title
B ¢ ot ct abave Dotas
j Contoot form Deait

' For lhls pamcu[ar teporf you cai.
choose the style you want to use for
the title. Simply click the oprion you

< _ prefer in the right hasd wigdow:and
click the Next bulton
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o Rep‘ortingﬂ.Dat'a

} o <+ Ckange Ihe mle of this report to
o : Custower Report
i msam«m@manmbmw . Siice we aré gomg to- want to add
fepord,
| NS o reoortor O ecoart's _ your name o the rcpon, bc surc you
: “desigr - c[ick Modify the- report’s de.ugn
i r buhqﬂ\camut. i
Click the Finish button.
m———ae 1 7 Display tolp on-rvoring vl the report ¥ /
Cancel I < Bk I ot II i I e
lh ﬂisll— is b q#! a 6*‘? ¥ oD h ‘.-__

The Report Form window will
appear. We want £o'add the words
PREPARED BY [YOUR NAME]
below the report header. To do ihls
you must activate the Tool Box. Find
the icon with the tools on the. mehiv
bar on top and chck it

b e ket

Select the label tool (Aa); click and
drag a text block the same stze as
Customer Report umimediately below
the report header, and type in the
phrase, PREPARED BY {YOUR:
NAME])

Save and print the report.

Creating 2 Data Base Report Page 3 of 3
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Customer List
Abe Zitwiger 123 4th St [Watertown [SD -~ [57201 | ™ |5 M
Yale Bumblehead 432 1st St Watertown [SD 57201 -
Candace  [Xerxes 1254th St [Watertown {SD 57201 (] M
Walter IDanforth 434 1st St Watertown D 57201 Y% b
Eunice l\_lelfont 436 1st St. (Waterfown [SD 157201 ] 1%}
lUister Fairmont  M381stSt. [Waterown SD. ~ [57201 i ¥
Gréta Thomas 126 1st St. Watertown [SD . [57201 L ‘M
Samuel  [Hooper 128 1st St. [Watertown {SD 57201 W
Student  {Student  |Student  [Student  [Student jStudent Y]

Page 1



Customer List

S Student .~ [Student  {Student. M
Yale Bumblehead 432 1st St. Watertown |SD 57201 bvi LJ
Walter Danforth ~ [434 1st St. (Watertown [SD 57201 |- M %]
Ulster - - [Fairmont ~ [438 15t St Watertown {SD 57201 vt M
Samuel - [Hooper [128 1st St Watertown 1SD 57201 )
Greta Thomas [126 151 St - Watertown [SD 57201 T
[Eunice  Merfont 436 tst St. {Watertown [SD 57201 L3 !
Candace  {Xerxes 125 4th St. Watertown [SD 57201 1 W
Abe Ziwiger 123 4th St Watertown [SD 57201 1]

Page 1
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SKill 3



CustOn. .o List

s

[Student . *Student  {Student . [Student ' [Student [Student vl $5.00 $0.00
Yzle Bumblehead [432 1st 8t. Watertown [SD 167201 %] Lt " $3.50 $3.50
Walter Danforth 434 1st St, |Watertown |[SD° 57201 v bl $5.00 $3.00
Ulster . |Fairmont 1438 1st S8t |[Watertown {SD 57201 2 i $5.00 $5.00
Samuel . |Hooper: 128 1st St. {Watertown [SD 87201 lvi 2 $5.00 $0.00
Greta: [THomas - . [126 1st 8t. (Watertown [SD 57201 L |72 $5.00 $0.00
Eunice Werfont 438 1st St Watertown iSD 57201 LJ 2] $1.50 $1.50
Candace [Xerxes 125 4th St Watertown 1SD - 57201 Ll ] $1.50 $1.50
Abe Ziwiger 1123 4th St [Watertown SD 57201 5 v $5.00 | $3.00

Page 1
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Customer List 9/9/2003

1Student  MStudent - [Student Student  [Student [Student
- 1Sarhuel Mooper . [128 1st St. [Watertown ISD 57201
Greta [Thomas 126 18t St. Watertown [SD (187201

CH&§

K| K

sownt  oF LI5S

=4



 Customer Query

Uister {Fairmont . $0.00
 [Greta Thomas $5.00 $5.00
[Gamuel _ fHooper '$5.00 $5.00
Student  'Student $5.00 $5.00
Abe Zitwiger $5.00 . $2.00
Nale Bumblehead $350 | $3.50 T 20.00
Candace [Xemxes $1.50 $1.50 $0.00

Page 1

=



Customer Report

Prepared by Your Name

Last Name ['Student |
First Name [Student i
Weekly Charge . $6.00 |
Collected | $0.00 |
Amount Owed L $5.00 |
Last Name [Bumbleheas

First Name {rale

Weekly Charge | $3.50 |
Collected B $3.50 |
Amount Owed [ $0.00 |
Last Name [panforth |
First Name waltes |
Weekly Charge | $5.00 |
Collected | $3.00 |
Amount Owed [ $2.00 |
Last Name [Faimont |
First Name [utster i
Weekly Charge [ $5.00 |
Collected [ $5.00 |

Amouuf Owed

Last Name
First Name
Weekly Charge
Collected

Amournt Owed

{Hooper f
e |
| $5.00 |
[ 500
C 5500

Tuesday, Septemnber 09, 2003

Skill 7

Page 1l of 2



Last Name _ j
First Name - EG"E‘a j
Weekly Charge | $5.00 |
Collected I m@
Amount Owed | - $5.00 |
Last Name Ierfont ]
First Name |“3‘"‘;‘°‘3 j
Weckly Charge | stsﬂ
Collected | $1.50 ]
Amount Owed | $0.00 |
Last Name penes ]
First Name [Candace |
Weekly Charge | | $1.50 |
Collected [ $150 |
Amount Owed | $0.00 |
Last Name [Zitwiger ]
First Name 1“’" ]
Weekly Charge |__; $5°E]
Collected F $3.00 |
Amount Owed I $2.00 |

Tuesday, September 09, 2003

Page 2 0f 2



Practice Access Problem

You have recently accepted employment at ezbz Inc., a for profit company desi gned to
teach students how to market and sell products from the classroom. Following an .
infensive training session on Access software, your'boss has appointed you the inventory
clerk. You are to create a database to keep track of the stock, and réport back to the boss
at the end of the week. You wili need to create the data base, create an eniry form, sort
the data alphabetically by product, add fields as necessary, filter for products from a
specific company, calculate the number of each product on hand, and prepar¢ a report to
the boss.

The following inventory data has been provided.

Product Company . | Number ordered | Cost : Selhng Price

Stainless-Steel Schoot 100 7.25 ' 10.00

Coflee mugs Products _ o _

Arrow Coffee School {500 2.50 | 5.00

Mugs Products . : ' .

Window Clings | Advanced 1000 .57 2.00

. Photo Studios

Shoelaces ShoefacesR | 250 147 3.00
Us -

Carabiners | Schoot 250 4.90 5.00
Products

Your name School Praducts

.« Createa database called ezbz, with ali necessary fields created
ol- * Create a form to enter the given data (see table above), and print a copy of the
table.
¢ Sort the data based on product and print a copy of the table.
Add a column labeled Number Sold, enter the given data, and print a copy of
the table.

L W
*

At this peint in time, you have sold 72 stainless steel mugs, 250 arrow
colfec mugs, 543 window clings, 100 pair of shoelaces, and 212
carabiners,

5. ¢ Filter for only products provided by School Products and print a copy of the

~ table.

(. » Create 2 new guery to add the calculated fiedd Number on Hand and add the
formula to subtract Number Sold from Number Ordered and print a copy of the
query. )

7 + Create a report that lists the product name and the number of items on hand
and print the results. )

Enrichment—Find a way 10 have the computer figure current profit (or loss) on each
product. Print a report with this information!



Access Additional Practice

You are helping your local Girl Scout organization with their annual cookie sales:
You have been asked to keep track of sales information for them. The data is

jisted below.

]. Create a data base of the existing information, create an entry form for the
data and print the resulting table.

Scout Name Scout Numbes | Sugar Cookies | Chocolate Peanut Buiter
Chip
Jane 1234 5 3 6
Jill 4321 7 12 9
JoLynne 1543 I 12 3
Jenny 1863 2 7 9
Jackie 1111 8 3 12
Josephine 1000 9 9 17

W our nawd_.

2. Sort the data base alphabetically by name and print.
3. Add Gingerbread cookies to the table and print

Scout Name Scout Number | Gingerbread
Jane 1234 5

Jil 4321 3

JoLynne 1543 0

Jenny 1863 7

Jackie 130! 1

Josephmne 1600 2

*You, 45

Query > >

print.

Find the total sales for each scout and print.
cookies together. (Jane’s total should be 19)
6. Print a report with the scout’s names and total sales.

the “Prepared by” and your name.

Staple the copies together in order and tum in!

4. Filter for all scouts who have seld 5 boxes of Gmgerbrcad cookies and
To find the total add all the

Be sure {o include




Thss IS ‘H/IQ-/
 4est.. DoNOT
B DO Th'g v

You teach a class callcd Intro to Computer to six students Thcy have takcn three tests
The data is fisted below. - '

Access Assessment

I Create a data base of lhc cmstmg mformatmn, creatc an entry form for the data,
and print the resulting table.
Original Data _ _
First name Lasi name Test 1 Test 2 Test 3
Mary Jones 82 | 8t 83
“Tom | Anderson 7T 93 9
Betty | Smith 88 93 {0
' Fred | Young 50 88 63
Bertha Butte 33 - 199 JES
You *You 89 | 87 0O

2. Sort the data base alphabetically by last name and print
3. Add test four and print

Last name | | Test4

.First name

Mary Jones ' 79

Tom Anderson 180

Betty Smith - |78

Fred Young 199 -

Bertha _ Butte - 88

You *You : 95

4. Filter for all students who haven’t taken test three and pnnt

5. Find the average score for all students and print—Hint—average is found by

adding the four tests together and dwndmg by four. Remember to place the
addition in parenthesis.

6. Print a report with the students” names and their averages. Be sure to inchide
“prepared by” and your name.

Staple the six printed copies logether and tum in.



Microsoft Access Enrichment

You are the owner of ACME Electronics. You manufacture electronic gadgets. Youare
trying to keep track of some employee information. Do the following: -

. Create a data base of the existing information, create an entry form for the data,
and print the resulting table.

Original Data

First Name | Last Name | Id Number | Employment Parts Parts Parts

Status Produced | Produced | Produced
Week | | Week2 | Week 3

Sally Jones 1423 Full Time 125 110 145

Jum Smith 10069 Full Time 123 115 132

Mary Olson 1873 Part Time 635 55 72

Buit Thompson | 1109 Part Time 60 57 71

You *You 1111 Part Time 1 1 1

2. Sort the data base alphabetically by last name and print.

3. Add Parts Produced Week 4 and print

N

First Name | Last Name | Parts Produced Week 4
Sally Jones 151

Jim Smith 149

Mary Olson 58

Burt Thompson | 59

You *You {

Filter for all employees who are Full Time and print.

Find the Total Parts Manufactured (Add all 4 weeks together)
Find the Average Parts Per Week (Divide the Total Parts Manufactured by 4).
Print a report with the employee’s names and their Average Parts Per Week. Be
sure to include who prepared the report.

Staple all reports together (in order) and turn in!




Microsoft Access Enrichment

You have just opened a new gardening service called Hoe! Hoe! Hoe! Your company
provides landscaping and yard care services. Through careful word-of-mouth
advertising, you have built up a customer base of 3 landscaping clients and 4 yard care
service chients. For the sake of record keeping, you include your name last as a yard care
client (making a total of 8 customers listed!). As the computer-savvy kind of person you
are, you now want to create a database to keep all the pertinent mformation. [SKILL #1]
Once you have entered the data found below, saved it and printed it, you decide you
woukd prefer to have the information in alphabetical order by last name, [SKILL #2] so
yoi sort it and print another copy. Then, you have the computer filter the database for
only those people who have yard care services and print. [SKILL #4] Do this much first!

{Edna [Fritzel 222 4th St. atertowniSD  [57201yard care
{Greta [Hansel 1234 Sycamore  |WatertownSD [57201}yard care -
IKitty {Lanyard 14532 32nd AvenuefWatertown!SD {57201{yard care
IMike [Nowyouseeme|1444 141h St. jwatertown{SD {57201 {yard care
Candy|Dutenhofer  [1234 6th St [Brookings §SD 57006;iandscape
Able {Billings 234 5th SL. WaterlowniSD {57201 ]landscape
ingrnd {Jones 231 7th SL WaterlownISD {57201 [landscape
[You *You Your Your ourfYour lyard care

‘While looking at your printouts, you realize that you could have the computer do your
math for you if you were to add fields [SKILL #3] for cost per hour and another for hours
worked, so you do so with the data found below. Remember to save and prnt it. Once
this data is entered, you want a list of all clients by first and last name, the type of service
they have, the cost per hour, the number of hours, and a query to figure out what they
owe. [SKILL #5} Print this much out.

$9.50

Able  |Billings $15.50 18
Candy{Dutenhofer $15.50 24
{Edna [Fritzel $9.50] 6
{Greta [Hansel $9.50] 8
Ingrid {Jones $15.50| 13
[Kitty {Lanyard $9.50{ 7
Mike |Nowyouseeme $9.50] 6

Finally, it is time to check with 1he anditor, so you need to create a report {SKILL #6] of
the query in columnar form titled Hoe! Hoe! Hoe! Records with your name immediately
beneath the title. Print this report. When finished, you will have six different printouts.
Place them in order by skill, staple them, and hand them .
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Access Babysitting Database

Imagine that you have taken a job babysitting this summer. You will need a way to keep
track of the total amount of money you make. Do the following:

1.

Create a data base of the existing information, create an entry form for the data,
and print the resulting table. Be sure for your information you put your first

initial and your last name. For example, I would put *Lkranz. Also, make sure
you adjust your field size before printing and check to see if it fits on one page.

Original Data
Family Number of | Cost per Hours Hours Hours Hours
Name kids Hour Week1 | Week2 | Week 3 Week 4
Johnson 1 1.75 10 10 15 10
Smith 2 4.00 40 40 45 30
Jones 3 6.00 20 30 20 35
Anderson |4 8.00 15 40 15 20
*You 3 2.00 5 5 5 5

2. Sort the data base alphabetically by family name and print.

3. Add fields Hours Week 5, Hours Week 6, and a Paid field with the information
below and print a new copy of the table. Be sure to adjust your fields and make
all information fit on one page before printing.

Family Hours Hours Paid
Naie Week 5 Week 6
*Lkranz 5 10 Yes
Anderson 40 10 No
Johnson 15 10 Yes
Jones 0 10 Yes
Smith 25 10 No
4. Filter for all families that have paid their bill.
5. Find the Total Hours and the Total Bill in one query. Be sure to adjust all column

widths and print on one page.

Print a report with the family names and their Total Hours and Total Bill. Be sure
to include who prepared the report.

Staple all reports together (in order) and turn in!









PowerPoint
‘This is Slide #1

by Mrs, Roby

- Slide #2

This is a slide show—the slides are guides

_ Font size and text boxes
Backgrounds and color combinations.
Graphics
Animation and Sounds

' Hyperlinks
Run the show
Print
"~ More is not always better!!

Slide #3

. -[IFont:size . :
«.. -MReadable from all over the room.
© - WAt least 24 point '

o B Vi

« - OFext boxeés—layouts

R _.-.bulle_ts. :

This is a separate text box

L



Slide #4

3 Backgrounds
® - Format to backaround
‘¥ Color schemes and combinations
m Fill effects B L
-- ‘M -Picture backgrounds
¥ Design vs original

Slide #5
——

Frorn:fil
browse

Slide #6 _

- :[k-Animation and-sound - - - e
- ..M Effect options. . . | :

- - - m-Order-and-timing-

. £} Slide. Transitions

More is not aMays better!!




Slide #7

03-Hyperfinks-
- ‘M Create a table-of contents
- 2 Link to the appropriate slide

- Slide #8 -

Run the slide show
*three ways

Slide #9

-, :[1-How:tg-print-both.views: .
M- Three stides:per-page: . .-
- -M- Slide-sorter-vigw- -

-0 -SEE HANBOUT:




How to print the slide show—three slides to a page:

1. Pull down file to print . '
2. Find the “Print What” window 2/3 clown the page and change ﬁom
- “slides” to “handouts”
3. Find the “handouts” window to the rlght of “Prmt What” and change '
‘to 3 slides per page )
4. Say OK to print

‘How to print the sli'dé_sbrt_er view:
Choose the Slide Sorter View : _ - N
. Click the PrtScim (print screen) button in the upper rlght part of the -
keyboard—~nothmg will appear to happen

3. Openanew Word document :
4. Right click on the window and choose paste .
5.

6.

IS

Place a header on your document
Prmt the document and staple to the back of your slides pnntout




| Powe-rPoihf Prob'lem #1

Create a PowerPoint presentatlon on. any t0p1c of your chmce (as long as itis
legal, moral, and in good taste according to the instructor). The presentation
must be minimally 5 slides in length. The slide show must contain -
transitions between the slides. Each slide must contain text, at leas_t one
graphic (taken from clipart, the intemet, or the digital camera), at least one
.ammatlon and one sound set under custom animation, and a visible
background with an attractive appearance. Each student must be prepared 1o
present this slide show to the class. (there is no time limit for this - :
presentation) Your presentation needs to include a verbal introduction to the
~ slide show, the slide show itself, and a verbal conclusion to the slide show.
You may use slides to help introduce and conclude the slide show, but they
must be in addition to the 5 content slides in your presentatlon Print both
copies of your slide show—the three slides per page copy-and the slide _
 sorter view. Keep these copies in your binder until you présent your slide
show to the class, This. presentatlon w1ll be graded with the. rubrlc onthe
follnmng page. . _ . .



| PowerPoint Problem Rubric

INTRODUCTION -
i . 5 1 4 3 [ 2 1 ]
Attention Grabber. ' N B T
' PRESENTATION '
5 4T 3T 2 3
Five slides '
Slide transitions
Background
C[Fext -
Animation
Sound -
Graphics o
- ]Appearance _
| CONCLUSION |
" 5 4 3 2 1
Retated back to Intro -
. |TOTAL POINTS

NAME

Prinfouts needed—both views:

three stides per page |

slide sorter view




PowerPoint Assessment

This assessment will check for the fb]lb\!i_ring skills:

Load PowerPoint software .Add text - Apply é.slide layout

| Create 2 new slide show Add animation ) Add graphics
Create aslide Incorporate sounds. -~ Apply slide transitions
Apply a background Create hyperlinks . |Usean mtro and conclusion
TASK:

Teach the class how to perform a certain task. The task must be one that can be learned
- by listening and watching you and your presentation. The task must be in good taste.
 The slide show must be minimally 7 slides long, with slide #1 being your opening slide
- used during your verbal introduction. Likewise, slide #7 should be your closing slide,
used with your verbal conclusion. Use the. rubrlc on the followmg page to help detenmne
what must appear on all slides. : _




Slide #

Requirement

Yes

1
Intro

Contains name of task to be demonsirated

Contains atiractive background

Contains appropriate graphic

Conlains name of presenter

Conlai’ns custom animation and sound

2
TOC

Contains transition into slide

{ Allows for hyperlink activity -

Contains attractive background

Contains text block -~ -

Contains appropriate graphic

_Contains cusiom animation and sound R

3
Content

Contains transition into slide

| Contains attractive background ~

Contains text block -

Contains appropriate graphic

Contains custom animation and sound

4
Content

Contains transition into shide

Contains attractive background

Contains text block

Conlains approptiate graphic

Contains custom ammation and sound

5
Content

Contains transition into slide

Contains atfractive background

Comntains text block

Contains appropriate gréphic

Contains custom animation and sound

6
Content

Coniains transition into slide

Contains attractive background

Contains text-block

Contains appropriate graphic

Contains custom animation and sound

7

Contains ﬁ*anSition into slide

—

Contains atiractive background

. Contains suminary text -

C@DC] Contains appropriate graphic .
11 appropriate grap
PO Contains custom animation and sound

- Introduction | Ca]'}mre'.s audience attention .
e Leads into topic '
t Coriclusion  |Summarizes main points -

Eresa | Relates back to infroduction ~ ~ ~

Printouis needed-—both views:




Powe"rPOint Ennchmenl

Task--Test lhe 'knoudcdgc of PowerPoini sc_»ﬁwaré on any student -

-Proocss*

Crc:ltc a PowcxPom( presentation thal lcsls any studcnl s !mowiedge on PowchomL You musl have an
introductory slide cx;)!ammg what they will be domg, You miust include a hypeslink button to move 1o the _

next slide. “You. inusi have five questions. The test’ qucsuons musideal with any aspect of the efeating
piocess (how 1o create a‘slide, how to animate a slide, how to h)'pcﬂmk, etc. The qucshons maybe
troc/false of muliple choice.- Each slide must be hyperlinked in the followmg nmnncr : :

- thcanswc;ﬂscydmknsngh{,hypcrluﬂcmanlothcncxlqu@cuon L '

+  If the answer they choose.is wrong, hypedink them to a page that c:q:rlamslhengmanmcr and Ihcn _

asks them 10 move on the to the next question.
Each slide must contain grapiucs of some kind (word art 1s consndercd a-gmphxc), tcxt, and ammahcm

Make each slide as attractive as possubic '

E




Media Partners Project
With the development of digital broadcasting resources, South Dakota Public Broadcasting is increasing its

capacity on the Internet. Simply put, they have more space/time than content they can create toTill it! They
believe there are many potential benefits in creating a “media partnership” with the students of Watertown High
School.

Project Summary
Utilize the skills of Watertown High School students to create multimedia presentations with audio/video

components that meet specific content and production guidelines, which can be co-distributed by SDPB.

Content Ideas and Guidelines
People - Students, teachers, family members, or people within the community with a unique achievement,
accomplishment, or contribution to the school or community. (Camera can not leave schooil)

Things - Unigue events with the school or community, and school or community icons

Peer to Peer ~ Students talking to students about life style, life experience, advice, trends, and promoting a
successful high school experience and personal growth and development.

You will create a media partnership presentation with PowerPoint and Movie Maker. The PowerPoint will
contain all details necessary to develop an understanding of the importance of the topic you have chosen. The
key component will be an embedded video created using photos and video clips captured using the HP
Photosmart Digital Camera and edited with Windows Movie Maker. Creativity and attention to detail is
mandatory as this presentation will be availabie to be viewed by alf people logging on to the SDPB website.

Media Partners PowerPoint to Video must include these items: 5 points per ltem
PowerPoint Yes No

The PowerPoint is well designed ... bbb b s
The PowerPoint is well OrganiZed...........o.cv oottt ee e e
The PowerPoint contains no grammatical errors
The PowerPoint contains no punctuation @rrors ..o
The PowerPoint contains classroom appropriate content and is factual ...
The forwarded presentation folder is properlty named/contains all data necessary to present.

PowerPoint Components
The topic is identified. ... e
The topic is Well defiNBd ........coiiii ettt sene st st
The impact on community, school or students is identified
Reinforces issues addressed inthe video..............o.vvvvvviiievininierere i
The PowerPoint has the video embedded inaslide ...
The last slide includes appropraite credit to used copyright material and people interviewed
Presentation

The presentation lasted between 5-10 MINUIES ..o e
There was a verbal iINtroducHON. ... s
There was @ verbal CONCIUSION ...t e re s e b
The presentation was well practiced

Qaoa aoaaodagx 0oaaaa
Qoo 0agadaoagz Qoo

5 points per ltem
Commercial Production Components Yes No
Includes voice audio in video ProdUCHON ...........coiviiiieerer i et
Includes audio music background (volume adjusted) ...
Includes additional pictures that support the video production ...,
Includes video effects (theme related and are a minimal distraction) ............ccooo i
Includes video/audio transitions (appropriate, minimal distraction, and consistent)
Effective use of Font, Size, Color, and Text Effects

Qaaaaa
gaoaoayg

This is a professional presentation for SDPB. Not your peers! Have fun but be appropriate when
completing various components of this project,



Compatible Audio, Video and Image Formats for Windows Movie Maker
Audio Formats: WMA and MP3 | Video Formats: AVl and MPEG | Image Formats: JPG, BMP and GIF

Preplanning:
+ Create a folder on you desktop named "username_media_project’
Chfeininge_media_project
Cut, copy or save all filtes that will be used in the project here
Rename all files to minimal names, example: Copy of 10 Favorite Song.mp3 to song_1.mp3
@'Cnpv of 10 Faverite Song.mp3 Renamed to @mﬂg_lmps
¢ This folder will not be backed up since it is not in your Home Directory because of file size issues

Open Windows Movie Maker:.

Click on “start” IERSEEN , "All Programs” All rograns § “Windows Movie Maker“@ Viindows Movie Maker
After Movie Maker is open, save the project in the folder (prewously created} as "username_media_project_video”

@ feiningc_media_project_video MSWMM (This is not a movie, it is the working file that the movie is built in, it can not be
played in Windows Media Player and cannot be sent to the WSD: Drive or to people via Email)
o SAVE OFTEN!IHIN WINDOWS MOVIE MAKER CAN BE A PAIN IF FILES ARE NOT SETUP RIGHTIHIIIIN

Navigating within Windows Movie Maker - Movi_e Tasks:
e First, click on “Show Timeline” 3 Show Timelne 15 view the timeline components

Tasks ,
» Click on “Task” E o located near the top/center of the screen to view tasks that can be completed

Click to import video clips from the working folder into Collections. These clips can
be dragged down onto the “Video” section of the Timeline and edited.

IClick to import pictures from the working folder into Collections. These pictures can
be dragged down onto the “Video” section of the Timeline and edited.

Import pictures Click to import audio files from the working folder into Collections. These audio files
Import sudia or music + can be dragged down onto the “Audio/Music” section of the Timeline and edited.

2. Edit Movie @ Click to view vour video, picture, and audio collections after they have been imported.
Shees colle o ] I i Collections IE Tasks ) i
View video e Click and at the top to view between Tasks and Collections,
View vi.deo transition Afier dragging clips onto the Timeline, click to view the Video Effects. These can
Make tiles or creds previewed in the Preview Windew then dragged onto video clips or pictures in the
Make an AutoMovie Timeline to change their appearance.

3. Finish Movie A fier dragging clips onto the Timeline, click to view the Video Transitions. These

can previewed in the Preview Window then dragged between video clips or pictures in|

Save o my compur . . " A

Save to CD the Timeline to create a transition between clips.

Send in e-mail After dragging clips onto the Timeline, click to add text to the movie. These can be puf
Send to the Web before, on or after video clips and pictures. You can change the animation, font, size,
Send bo DY camera

font color and background. If placed on the selected clip it will be located in the “Title
Overlay” section of the Timeline, If placed before/afier the selected clip it will be
located in the “Video™ section of the Timeline.

This is the final step in creating a movie. You must do this to create a movie that can
be play in Windows Media Player. This step takes the working Timeline and creates a
[WMYV file. Refer to the Finish Movie section of this handout.




« Complete the Movie Maker tasks in this order (Use the “Timeline” view NOT the “Storyboard” view):
o Movie Tasks - |- Captwre Video  (3)

* Import videos, pictures and music.
= Drag videos, pictures and music into the Timeline

o Movie Tasks - 2. EditMovie

= Drag video effects onto video clips and pictures on the Timeline
= Drag video transitions between clips
s Add text beforefafter and on clips.

o Movie Tasks - 3.FinishMovie @

*  Follow these steps to convert the project into a compiled viewable video
*  Click *Save to my computer” Save i say computer

Save Movia Wizard

Saved Movie Fle

Enter infomation for yaur saved movie e, e Enter the name you want your video to have. An
: example is: feininge media_project_video

Browse for the working folder where all your
working files are. This is where the compiled
video will be created.

Press next to go to the next screen

Save hovie Wizard

options

to view these

Muvie Setting
Select the setting you wart 1o use to save your movie, The seiting you select

mmhmﬁymdﬂemdmmdmm

Select “Other Settings”

Select “Video for broadband (512 kbpsy”

Press next to go to the next screen

Save Movie Wizard

Completing the Save Movie Wizard

:&.I;B\fa&mwﬂﬁﬁlhs Save Movie Wiard ard ssved your movia tothe
you spacified

In this screen Movie Maker takes ali the video The movie is now compiled and can be viewed in the folder we
clips, pictures, music and texi and converts it created in the preplanning section and was selected at the beginning
into a Windows Media file that will play ina of Movie Task 3 — Finish Movie.

media player. This file can be forward to the
'WSD: Drive or sent in an Email.




Tools within Windows Movie Maker — Preview Window:
Timeline: Thp 001

[Press the Play/Pause button to preview the movie, transitions_
and video effects, Use the Pause butten rather than the Stop
button while editing clips to prevent the movie from starting
over (from the beginning) when you press Play.

Press to split the gelected clip at the current frame. This is used

when working with videcs-and andio. You can remgve excess
footage or music.

video B
Transit
Audio
Ausdio fiusic
Title Overlay
Windows Movie Maker — Timeline: ‘//—ldick to change to Storyboard or Timeline view |
A e i Sontihi ICreate a narration with this button |

0:00:26.00

‘ I - H
.00 .
--------------- ; Video clips, pictures dragged down from the
- Collections and before/after text

ransitions dragged down from the Video Transitions i

Transition
Audio Audio that was recorded with the video clip |
AudofMusic (R Tmomtsemydastiiospison st s e IMusic that was dragged down from the Collections |
Title Dverlay ext that overlays video ¢lips |




Slideshow Safety

I have been to my share of conferences and have sat through my

share of workshops. Increasingly presenters, both professional and :
from the field, are coming armed with computerized slide shows. And 1
have seen the good, the bad, and the truly ugly uses of these things.
Hey, I've MADE good, bad and ugly computerized presentations

myselfl Unfortunately, most computer technology comes only with
how-to instructions, rarely with how-to-do-it-safely instructions. Since -
slideshows are usuaily public (presented) and noticeable, T am offering
some safety tips for you as a presenter: '

‘1. Have something to say. Pretty pictures and lots of technology
will never make up for the lack of interesting ideas and useable
information. You can put all the pretty clothes on your dog you want,
but he's still a dog.

2. Organize it. My English classes taught me to get a message
across. In a talk you have to tell the audience what you are going to
tell them, tell them, and then tell them what you just told them. Good |
presenters use an outline to put their talks together logically. Use an
introduction to the topic, then talk about the topic information, and

use a conclusion! And then use graphics, colors, or other on-screen
guides to help the audience stay on track and enhance the '
presentation.

3. Don't let the slides be the show. The slide show should aiways
be the second banana in any presentation. You, the human one, need
to be the focus of the audience's attention. That means things like eye
contact, enthusiasm, gestures, vocal variety, practice, and other basics-
of good public speaking are still as important as ever. Stand off to the
side of the screen when you present. Use a remote 5o you can get
closer to your audience. And PLEASE don't turn around to read the
slides off the screen. Think about it: would you rather the world was
jooking at your face or your backside?

4. Use a good projector. Poor projectors, especially LCD panels, _
require a room to be very dark. Dark rooms induce sleep. Enough said.



5. Use good slide formatting techniques. Here are some very
basic rules of thumb about slide formatting:

o Never have more than five lines of text on a slide with more than:
5 words in each line. Less is more, '

e Always use font sizes of at least 24 point for text and headlines
of at least 36 point. Bigger is better.

s Cute fonts are hard to read. Plain fonts are easy to read.

¢ Use high contrast colors and simple backgrounds. Make the
message jump out,

» Never sacrifice readability for style.

6. Don't go overboard on special effects. Like any kid with a new
toy, I had to try out all the bells and whistles that came with my
presentation software: sound effects, music, animations, cute
graphics, and spiffy transitions. And, boy, did I get comments about
my presentations! The problem was that the comments were not about
my topic, they were about the special effects. Attention-getters when
used sparingly really do get people's attention. But don't over do it.

7. Use graphics for a purpose. We forget that many, many adults
as well as children are primarily visual learners. And for all of us, a
good graphic image can communicate a concept with more impact
than words alone.

8. Proofread. Spelling errors in 48-point type projected 3 feet tall are -
lots more embarrassing than spelling errors in 10-point type on a
page. And please remember that spell checkers don't catch everything.

9. Practice. Most of us get nervous enough having to talk in front of a
bunch of people. Add to that situation the often-unpredictable nature
of technology, and you have a recipe for big-time stress. There are a
couple of things you can do to minimize the terror. First, practice using
the computer and projector. Second, practice giving your presentation.

10. Have some fun! Handouts with views of each slide are a good
back-up. You can put notes on the handouts to use when you present.



Websites to use for PowerPoint

For sounds:

www.1lovewavs.com

http://frogstar.com/wav

Or search for “free wav files”

For graphics:

www.animfactory.com

www.animation-central.com

www.animationlibrary.com
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Front Page Directions |

L Load in the FrontPage program from the tool bar. (It is the blue box with an arrow
on a circle 1n it—when you place your mouse pointer on it, it will say Frontpg.)

2. Notice the page that opens.

& Microsa!l FlomPage

Browser icon

3. Use the page as you would-a word | processor Snnply crcatc the page you want
Remember to save frequently and always saveé before you preview ‘the page.

Preview tab

4, To preview the page, either click the Preview tab in the lower left comer of the
page or click the icon labeled Preview in Browser on the format tool bar. (Located
between the printer and the spell check icons). The second option is probably the best.

5. Use the toolbars to set the font size and style to your liking. Format the text and

background color so it is visually appealing. (You will locatc these options by going to
format to background.)

6. To set hyperlinks within thc page itself (intermal) or to an ex:shng web site
{external).

A. Internal Link _

1. Highlight the target (the Iocation to which you want to
£0)
Chick the Insert menu option
Click the bookmark option
Name the bookmark appropriately and press return
Highlight the link (the item you will click on to go to the
bookmark)

il




.. External Link

~ L
2.
3.

-

" Click the Link icon on the toolbar (the globe with two

chatn links below it)

Click the bookmark option on the bottom of the page and
select the appropriate bookmark. _

Check fo see that the program has responded correcily.

The bookmark (target) should be underlined with a
broken line. The link should have changed color and be

- underlined with a solid line. Click either the preview tab

or the browser button to see if it works. If you click on a
link, does it take you to the bookmark (target)? If the
answer is yes you have been successful.

Highlight the link text (or picture).

Click the link icon on the tool bar (the globe).

In the URL line, type in the internet address of the web
link to which you want the computer to go.



FrontPage Assignment #1 €~ E i chmeadt A

Design a recipe web page which contains any four of the eight recipes given. The page
must meet the following requirements:

1)
2)

3)
4)

5)

Enrichment: author tries one of the recipes

Back'ground is changed from original form'—_must be subtle!
Introduction must explain what the page will do
Will give them a choice of four different recipes
Will give ingredients
Will give directions :
Encourages e-mail response once the recipe has been tried
_ Includes a picture of the author of the page
Introduction links to table of contents - :
Table of contents links to and from four recipes or to a “quit” window
recipes must be isolated.
ingredients must be entered 1n table form
directions must be written in paragraph form
graphics must be included
e-mail link must be inchuded
qult page thanks them for running the program and directs them to two
-outside links—www.floras-hideout.com/recipes and www.epicurious.con

e

ro e g

and shares results of the trial with the class.

K FrontPage Assignment #2

Create a personal web page. This page must meet the following critena:

>

>
>
>

v

Must contain an introduction

Must contain a menu to at least 4 separate “descriptions” of you, each of which
must be a separate page with changed backgrounds

Must contain appropriate links between pages

Must contain a “links” page that includes internet sites you think are good (each

- of which must be legal, moral, and in good taste according to the instractor—if

you have questions, ask!)

Must contain a concluding page thanking them for visiting and encouraging them
to e-mail you.

This Page WILL NOT BE PUBLISHED! You should NEVER place personal
information on the web that contains where you live or how to get in contact with you.

Format this page so it is as attractive as you can make it! Experiment W1th backgrounds
sounds, etc.



Personal Page Assignment—seven different pages

Introduction Page

Tell what we can expect to find

Include your picture
Link to the table of contents -\

\
Table of Contents IL

ersonal page |
ersonal page 2
ersonal page 3
ersonal page 4

/-—~Quit page

=) Personal page 1

N

Personal page 2
Link back to TOC

Personal page 3
Link back to TOC ~H

A\

Personal page 4
Link back to TOC

Link back to TOC =1

Link each to the
corresponding

page

\

Quit Page
Thanks for visiting
Include outside (external) links
Email




Recipe Page Assignment—all one page

Introduction Section
Tell what we can expect to find
Include your picture

(return several times)

Include a link to the table of contents

Bookimark-> Table of Content
- Recipe 1 ~__
ecipe 2

Recipe 3

ecipe 4

it page (return several times)

\J Boskwark=Recipe 1
Use rubric for specifics
Link back to TOC
(return several times)

\l%mv ¥Recipe 2

Use rubric for specifics
Link back to TOC
(return several times)

\-‘Bb'hmt—Rempc 3

Use rubric for specifics
Link back to TOC
(return several times)

ksBooitmanrl’r-Rccipe 4

Use rubric for specifics
Link back to TOC
{return several times)

[y

Link each to the
corresponding

section (use the
AIrOws)

N Bookmaurit-Quit Section
Thanks for visiting
Include outside (external) links
Email




. |

Skills

versong raﬂb Requirement

Yes

No

Background

Is the intro page background attractive and easy on the eye

Is there a different background for each subsequent page

Do text and graphics show up well on all backgrounds

Intro
Page

Does it explain what the page will do

Does it link to the table of contents

Does it contain name of the author

Does it contain a picture of the author

Is it isolated

Table
- of
Contents

Does it identify itself

Does it list 4 personal options

Does it list a quit option

Is it linked to each personal page and the quit page

Is it isolated

Personal

Page #1

Is page atfractively formatted

Is page grammatically correct with no spelling errors

“Are graphics included

Is the page linked back to the table of contents

Is it isolated

Personal
Page #2

Is page attractively formatted

Is page grammatically correct with no spelling errors

Are graphics included

Is the page linked back to the table of contents

e

Is it isolated

Personal
Page #3

Is page attractively formatted

Is page grammatically correct with no spelling errors

Are graphics included

Is the page linked back to the table of contents

Is it isolated

Personal
Page #4

Is page attractively formatted

Is page grammatically correct with no spelling errors

Are graphics included

Is the page linked back to the table of contents

Is it isolated

Quit Page

Does it thank viewers for running your program

Does it link to two outside websites

Does it offer the author’s email address

Assignment
Folder

An assignmeni folder is created

The FrontPage document is saved in folder

Backgrounds, graphics, sounds, etc are in folder

Document is error free—grammar and spelling




Skills

)
KL m% Requlrement

No

Background

Is it visibly changed -

Yes

Is it attractive and provide easy viewing (subtle)

Do text and graphics show upwell on it -

Intro
Section

Does it explain what the page will do

Does it link to the table of contents

Does it contain name of the author

Does it contain a picture of the author

_Is it isolated

Table
- of
Contents

Does it identify itself

Does it list 4 recipes

Does it list a quit option

Is it linked to each recipe and quit option

Is it isolated

Recipe
#1

Are ingredients entered in table form

Are directions written in paragraph form
Are graphics included '

Is ihere a link back to the table of contents

Is it isolated

Recipe
#2

Are ingredients entered in table form

Are directions written in paragraph form
Are graphics included . -

Is there a link back to the table of contents

Is it isolated

Recipe
#3

Are ingredients entered in table form

Are directions written in paragmph form

Are graphics included

Is there a link back to the table of contents

Is it isolated

Recipé
#4

Are ingredienté entered in fable form

Are directions written in paragraph form

Are graphics included

Is there a link back to the table of contents

Is it isolated

Quit
Option

Does it thank viewers for running your program

Does it link to two outside websites

Does it offer the author’s emat] address

Assignment
Folder

An assignment folder is created

The FrontPage document is saved in folder

Backgrounds, graphics, sounds, etc are in folder _

Document is error free——grammar and spelling




1 targe jar dry roasted peanuts

1 bag minature marshrmallows

1 pkg. peanut butter chips

3 Ths. butter .

1 can sweetened condensed milk

Generously butter a 9X12 cake pan.

Sprinkle half the nuts into the pan.

In microwave, melt chips and butier for 2 min.
Add sweetened condensed milk and blend.
Pour over marshmallows and stir to coat.
Press marshmallow mixture onto peanuts.
Sprinkle remaining peanuts on top.
Refrigerate for 4-24 hours and serve.

{Chocolate Chip Cookies |
1 cup butter

1 cup Bulter Flavored Crisco
2 cups white sugar

2 cups brown sugar

2 isp. vanilla

4 eggs

4 cups flour

5 cups ocatmeal .

2-1sp. soda

2 tsp. baking powder

1 tsp. salt

212 0z pkg. chocolate chips

Cream shortening and butter.

Add sugar and beat until mixed,

Add eggs and beat until fluffy.

Add vanilla. o
In separate bowl, combine 2 cups flour and 2 cups oatmeal,
Add 1 tsp. salt, soda, and baking powder.

Stir untit well mixed.

Add remaining flour and oatmeal.

Add 1 tsp salt, soda, and baking powder.

Stir until well mixed.

Add liquid ingredients.

Stir until well blended.

Add chocolate chips and stir.

Bake at 375° for 7-9 minutes uniil done.



ICarame! puil-aparts l

Serves 12

3 pkgs. refrigerated buttermilk bisquits
1 cup sugar

3 Tos. cinammon

1 cup dark brown sugar

12 cup cream

H3 cup vegetable oil

Preheat oven (o 350°.

Generously grease a heavy Bundt pan.
Separate bisquits.

‘Shake each bisquit in cinammon/sugar mix.
Stand on end in Bundt pan,

Mix brown sugar, cream, and oil.

Pour over top of bisquits.

Bake for 30 minutes,

Let cool slightly and invert on serving plate.

[Rhubarb-blueberry jan‘T‘]
7 cups cut rhubarb
3 cups sugar
1 can blueberry pie mix
2 small packages raspberry jetlo

Combine mubarb blueberries, and sugar. Let stand 15 minutes.
Bring 10 boil and boil 12 minutes.

Remove from heat and add jelio.

Place in sterilized jar and seal.

o

S



EPICURIOUS: RECIPE: CHOCOLATE BROWNIES ' Page 1 of3

=% Home }Recipes | Eating | Drinking | Playing | Bon Appétit | Gourme
Forums | Epicurious TV | Dictionary [ Members | Help | Search

Save to your @ Fiewr your Fr-mail this recipe

recipe box recipe box to z friend ] '{gl‘::;
CHOCOLATE BROWNIES | y |
"The Farm of Beverly Hills has the most incredible, delectable giant 95% would make it
brownies!" says Cindy Grand of San Francisco, CA. "They taste more _ ésam
like fudge with a light, crunchy surface. Would you help me get the RATE;

recipe?”

These are probably the fudgiest brownies we've ever tried—in fact, they -
seemed too rich to serve in giant squares, so we've cut them smaller.
They taste even better the day after they’re baked.

Active time: 20 min Start to fimish: 3 hr:

3 sticks unsalted butter; cut into pieces :

12 oz fine-quality bittersweet chocolate {not unsweetened), chopped
6 large eggs - o

1 1/4 cups cake flour (not self-rising)

1 cup plus 2 tablespoons unsweetened cocoa powder (not Dutch

process)
3 cups sugar ¥ pasta
1/2 teaspoon salt ¥ Rice

® Beans
Preheat oven to'350°F. Butter and flour a 13- by 9- by 2-inch metal * Oil
baking pan, knocking out excess flour. Melt butter with chocolateina 4 yinegar
large metal bowl set over a saucepan of barely simmering water, ¥ Merbs & Spices
stirring until smooth. Remove bow] from pan and whisk in eggs, 1 ata Butcher Shop
time. Sift together flour and cocoa powder in a separate bowl and stir | Cheeses
into batter with sugar and salt. Pour batter into pan and bake in maddle b Baking

of oven until top is firm and a tester inserted info center comes out with
crumbs adhering, 40 to 45 minutes. Cool completely in pan on a rack,
about 2 hours, before cutiing info 20 squares.

Cooks' note: )
* Brownies keep, layered between wax paper in an airtight container, 5 days.

htto:/fwww epicurious.com/run/recipe/view 7id=102992 04/24/2001



TPISTACHIO BREAD |
1 pke. white cake mix 12 aip water
I pkg. pistachio pudding mix . | cup dairy sour cream
1/4 cup oil . 12cap chopped nuts

EEREEREEE

1/4 cup granulated sugar 1/2 tsp. cinnamon

10 a large miixing bowl combine the first 8 ingredients until well blended.
" “Grease and flour 2 loaf pans (or use small pans). Combine sugas and

cinnamon. Sprinkle half the mixture on bottom of pans. Spoon in batter,
then sprinkle remaining sugar on top of batter. Bake at 350°F. for

* 40 16°50 minutes, depending on size of pans. Cool in pans 10 minutes;

remove bread from pans and cool on wire racks. Makes 2 large foaves or
several smaller loaves. This bread freezes well!

[POPPY SEED BREAD
1 pkg. yellow cake mix 4 eggs _
A, pkg. instant coconut pudding 1/4 cup poppy seed
3/4 cup salad oil 1 cup hot water

Soak poppy seeds in hot water about 5 minutes. Preheat oven to 350"F.
Grease 2 loaf pans. Mix cake mix, pudding mix, oil and eggs together.

~ Add poppy seed/water mixture. Beat 4 minutes. Poor batter into pans. -

- -Bake 50 minutes. Cool 10 minutes, then remove from pans and cool
- vomapletely. Optional: Bake in smalt loaves, in a greased bundt pan or

angel food cake pan, Adjust baking time for type of pan used.
Use a lemon cake mix and instant lemon pudding.

** A fengthwise crack in the top of fruit loaves is common.

** Cool lpaves completely before slicing them to prevent
crumbling.

** The flavors mellow, and slicing is easier, if the loaf is

cooled, wrapped and allowed to stand for a day before
serving. :

43
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Another Recipe Courtesy of Flora's Recipe Hideout ‘ Page 1 0of 1

-

Another Recipe Courtesy of Flora's Recipe Hideout

! lhphocofate Caramel Pecan Chee%ﬁfﬁgg].

Recipe By :
Serving Size : 1 Preparation Time :0:00
Categories : Cheesecakes Chocolate
Amount Measure Ingredient -- Preparation Method
2z Cups Cookie Crumbs
6 Tablespoons- Butter Or Margerine
14 Oz. Bag Caramels
5 Oz. Can Evaporated Milk
1 Cup Pecans —-- chopped
lé Cunces Cream Cheese —-- softened
1/2 Cup Sugar
2 Eggs
1/2 Cup Semisweet Chocolate Chips — melbted
1 Teaspoon Vanilla

Preheat oven to 350F
Mix crumbs and butter, press onto bottom and sides of 9-inch
springform pan.Bake 10 minutes. '

Microwave caramels and milk in small bowl on high for
4 - 5 minntes or until melted, stirring every minute.

Pour over crust.
Top with pecans.

Beat cream cheese and sugar until well blended.

Add eggs, one at a time, mixing well after each addition.
Blend in choccolate and vanilla.

Pour over pecans.

Place pan on cookie sheet.

Bake 45 minutes. Loosen cake from rim of pan, cool before removing
rim of pan. Keep refrigerated. Garnish with whipped cream.

Back to Flora’'s Recipe Hideout

htto:/’www_floras-hideout.com/recipes/mxp/checake/68 html _ 04/24/2001
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Literacy Integration Lesson Plan
Name of Lesson: Introduction to Excel Unit
Teacher: Annette Roby

Class: Intro to Computer

Activate Prior Knowledge

Anticipation guide: Using a concept map I will introduce the unit Excel. They
will fill out the form first alone and then I will partner them up and let them compare
their thoughts about what Excel is, what are some examples, and what it is like before
introducing the software.

Set a Purpose for Reading

Unit tour: Using the terms for the unit and a blank spreadsheet (with LCD
projector) discuss and demonstrate each term and its function so the step by step
directions provided make sense to the student.

Monitor Comprehension

After demonstrating Lesson 2 have students get on their computer and follow the
step by step directions and complete the lesson. Completion of the lesson will show their
ability to follow technical writing instruction.

Organize, Capture, and Remember What Is Read
After completing Lesson 2 the student will go on to Problem 2 and complete the
problem using the skills and concepts learned in lesson 2.

Reflect and Apply
The student will turn in Lesson 2 and Problem 2 for a grade.









:Sprcadsheet Tcnmnology o -'-;- ' ] : . o 6?‘3'

N

10. .

1.
12.
13.

14.
15.

Spreadsheet Lesson #1/Problem #1

L

T

.Be certain you understand each 0f the followmg 15 terms.

Spreadsheet problem #1 wﬂl be a qmz over the matenal. You

must get at least 85% before proceedmg to Lesson 2.

Colu mns~—Vertical—~—Always go up and down—Always labeled alphabelical_ly—-
ATV |
Rows—Honzontal—AIways go across“Aiways labclcd numencaliygl-ﬁﬁ 536 !

- Cellﬂlntersccnon of a row and a column-——lﬁ 777 216 avaﬂablc

Grid—The combination of the intersection of all columns and rows'.:"’i"'?"' |
Active cell—The cell into which data will go.

Indicated by a dark line around the cell
Also mdlcated by the—

Name box~—~Found above Column Aﬂalways .. d1 e

thé'cuirent active cetl

Formllla bar—the longwhlte rectangle ie box—also

refcrred to as b c'entcr barw—As you cnter.t __xt, it gb m 'lﬁié'box untii you

placc itin thc spreadshcct using return, tab, the entcr box or the arrow keys.

-St»atus baeround a{ the bolmm of the spreadsheet Tells when computer 18
re.ady for data | P P
i Caucel ox~—Found between ihe fannu]a bar and namic box At 1s a square with a

| _ largc X in: 1t- If you do not want [hc contents of the formula bar to go into the

actwe celL, cllck this, X

Enter bomeound next tﬁ the canccl box It is: 2 square a_"check mark i it. -

If you want the contcnts of ihe formula bar go mto the actlve cell click the enter

box

‘Text—any entry that thﬁt'ai__t"_lf_s_\letters; spaces, OF non/mathematical punctuation

"‘Numeric—Any number or scientific notation

Formula—Mathematical direclionﬂ*;lways uses order of precedence—always
starts with an equals symbol (=)
Workbook<—A spreadsheet document created by the computer

Worksheet—One page of the Workbook

e
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Spreadsheet Lesson #2

Fundamentals

Concepts:

Create a new spreadsheet workbook
Place a header on the worksheet
Place data nto a worksheet

- Use mathematical formufas
Copy into open cells
Format the spreadsheet
Set the Page Setup to print according to directions

1. Create 2 new spreadsheet workbook and save it as Spreadsheet Lesson 2.
A. Click the Start bution, click the Programs button, find and click the Microsoft Excel butlon
B. Reserve space for the document :
1. Pull down File to Save As
2. . Click the down arrow to the right of the Save In box
3. Click the location m which you wish to save
4. Type Lesson #2885 in the name box and click Save
2. Add the appropriate header
Click the View menu option
"Click Header and Footer
On the window that comes up, find and click Castom Header
In the lefi column, type in Created by and your name
Press tab to move to the center column and type in the File Name—Lesson #2585
Press tab to move to the right column and type in today’s date
Click OK and OK again
3. Enter the following data into the spreadsheet in the following manner: B o
A. Click in cel! Al and key in Employees Names—press tab e 7
B. You should now be in cell Bl—key in Hourly Wage—Press tab
C. Key in Hours worked (in cell C1) and press enter—the computer should take you to celi AZ
D. Enter the remaining data so the spreadsheet looks similar to the data table below

omppNws

e

DATA DATA DATA DATA DATA DATA DATA DATA DATA DATA DATA DATA DATA DATA. _ L

Employees Names | Hourly Wage Hours worked

Ron Smth 7.5 35
Richard Jones 775 39
Hamiet Johnson 9.95 42
Cathy Zubke 12.35 51
Bill Zubke 4.45 16

DATADATA DATA DATA DATA DATA DATA DATA DATA DATA DATA DATA DATA DATA '

4. Find the amount eamed by each employee
A. Click in cell D1, key in the text Amount Eamed, and press the down ammow to move to cellD2
B. Tell the computer to do the math—Hourly wage hmes Hours worked
. Begin with an equals (=) symbol
2.' Click on cell B2 {(the hourly wage for Ron Smith)
3. Place an asterisk (*) in the formula (the computer symboel for multiplication)
4. Click on cell C2 {the hours Ron worked) The entry bar should read =B2*C2
5. Press the enter key-—the computer place the correct answer {271.25) in cell D2
C.  Copy this formula into the remaimmng four cells
1. Click on cell D2—notice the hiuale box in the lower right corner
2. Click exacily on this box and drag down through {he remaining four celis. The compuler w:]l
automatically place the correct formula in each of these cells. .



Spreadsheet Lesson #2

Format the spreadsheet

A, Set the Colurmm width _
1. Selecit all the cells—hold the conwol key down and press the letter A (for ALL)
2. Chick the Format menu option
3. Click the word Column
4. Click the Auto fit option and press OK

B. Set all dollar amnounts to curzency ,
1. Click the Column marker B (ihe entire. cohnnn should become highlighted) [all numeric items :

in this column WILL be dollars—1text items will not be affected]
.. 2. Click the Formai menu option )

3. Chick Cells
4. Click the Carrency Option
5. Click OK
6. Repeat for Column D (Also a money column)

Set the Page Setup

A, Click the File Menu Option

B. Click on Page Setup

1. Click the Margins Tab at the top of the window—Click to Center on Page Horizontally
2. Click the Sheet Tab—<click to turn on Grdlines and Print Row and Column Headings
3. Click OK

Print the document with values showing—File to Print and click OK
Print the document with formulas showing

Al

C.

Find the Accent/Tilde key on the upper left row of the numeric keypad. Hold the control key
down and press it—the computer will automatically shift all values derived from formulas to the
formulas themselves. Do not panic, it will also take away the currency formatting youn did. This is
what is supposed to happen! Autofii again!

Do-a print preview to be sure that everything fits on one page and print the formulas. Stapie the
two sheets together (vahtes copy on top) and hand in. DO NOT TURN IN A SINGLE COPY IN
THIS UNIT. YOU WILL ALWAYS TURN IN VALUES AND FORMULAS!

To return to the values window, Control Tilde and autofit! |t will take you back to your original
document. ' '



Sr:eadsheet Problem #2

Given the data below, create a new spreadsheet {with appropriate header} to find the amount of tax for each
item and the total price for each item. (You will have to add two more columns—one for the total tax cost
and one for the total cost.) Be sure each column is fabeled. Format the columns to aute fit. Format
currency to dollars. Center the spreadsheet horizontally on the page. Print with gndhnes and column and
row headers showing. Print with formulas showing. Staple together and hand in.

{tem Cost Tax
Shirt 34.95 07
Slacks | 44.95 | .7
Sheets 4995 | .06
Towels | 33.95 | .06
Shoes 4995 | .05

Create
Place a header
Place data
Use formulas

Copy into open cells
Format
Print according to directions




Lesson #3—Formatiing data

Spreadsheet Lesson 3

Concepts:

10.
H.

Load a document previously saved
Insest rows/columns

. Merge and Center

Format cell contents
Manually re-size columns
Color highlight

N Load in the spreadsheet you saved for problem #2—Click on File, click on Savc As and

save as Lesson 3. .
Change the header so that it i3 appropriate (name it L&sson 3)

Place a blank row at the top of the spreadsheet

A. Click on the row 1 marker (the number 1 on the far left)
B. Click the Insert menu option

C Click the Rows option

Place the label “Tax Cost” centered across the top of the entire spreadsheet

A Click in cell Al

B. Type in the words Tax Cost

C. Click the enter check {green check mask)

D Click in cell Al and drag through cell El (highlight, do not copy)

E. Click the Merge and Center button on the tool bar—located directly to the left of
the dollar sign ($).

Format the new label

A Double click the words Tax Cost

B. Highlight the words Tax Cost

C. Change the font to something different than Aral

D. Change the font size to 20

E. Click the Row 1 marker to resize

Place a biank column between A and B

A Click on cell B2

B Click on the Insert menu option

C. Click on Columns

Set the size of the column to 1 point

A Move the mouse so the pointer rests between columns B and C (it should become

a straight line with arrows pointing in each direction). Click and drag until the
width indicator says 1.00. '

Color highlight the blank column
A, Click on cell B2 and drag through B7
B. Click the color highlight button. (Paint can—filt color)

Bold the Totat Cost-—figures only—do not bold the label.
A. Click on cell F3 and drag down through F7
B. Click the Bold butfon on the format menp {the big leiter B)

Save and print with values. Press control and tilde key, antofit, and print with formulas.
Staple with values copy on top and place in your binder.
DO NOT TURN IN LESSONS



spreadsheet problem #3

—
.

Create 2 new spreadsheet calied Spreadsheet Problem 3
2. Based on the data below, find the tota} amount of money raised by each concession item and the total
- amount raised by the concession stand.
3. Fomat the spreadsheet in the following manmer
A. Anto fit the columns
B. Currency to dollars
C. Center the spreadsheet horizontally
D.- Gridhines and column and row headings should show
- 4. Print (values only) but de not hand in! When finished, make the changes listed below the data!

Ttem Poce | Mon | Tues | Thur } Fn

Orange soda. § .65 97 | 85 32 97
Cola .59 29 35 1 64
Lemonsoda | .83 31 |5t 64 37
Hot dogs 155 |29 38 21 39

Changes:

1. Add a row to the top of the spreadsheet. Place the label Concessions centcred actoss the spreadsheet.
Format the title so it is at least 20 points tall and attractive to read

2. Tnsert a row between Lemon Soda and Hot Dogs to enter the following data

[Tce Cream Bar ] 126 [38 |91 54 {29 |

3. Insert a columan between Tuesday and Thursday to enter the following data

Wed
92
82
71

4. Copy the formulas down into the new row so that Ice Cream Bar has all the necessary information.

5. Reformat so all data shows (highlight the data and Format Columns to Autoﬁt)

6. Bold the total mised and print

7. Print with values and formulas: Staple the three documents togethes—edited copy on top and subtmt




Spreadsheet Lesson 4

Lesson 4—Percentage and Charts

Concepts:
Finding percent
Charting

1. Load in the spreadsheet you saved as Problem #3.

2. Add a column to find what percent of total money was raised by each item
A Click in cell J2
" B.  Key in the label, Percent, and press the down arrow
C. Enter the formula for percent of total money raised by Orange Soda:

part divided by the whole—in this case: total money raised by orange soda
divided by total money raised the the entire concession stand. The
formula would be:  =I3/I8

D. Find the rest of the percentages for each concession item.
NOTE—you cannot use the copy down feature here. Part of the formula is an
absolute rather than relative referenw—somethmg you will learn later.

E. Format the column to percentﬁhlglﬂ:ght column J

I. Click the Format menu option
2. Click cells
3. Click percentage and check to see that decimal places is set to 2.
4. Click OK
3. Create a chart to compare the total sales of each item

A Highlight the data in 13-17

B Hold the Ctrl key down and highlight cells A3-A7

C Click the Chart option on the tool bar (the multi colored columns next to
the globe

D. Choose the Pie option

E. Click the second pie choice in the top row

F Click the Next button on the bottom of the window

G Click Next again

H Click Data Labels tab

| Click Show Percent and click Finish

J Click on the non-printed part of the chart and drag it below the existmg
data on the spreadsheet so that all data shows.

4. Check to see the percentage printed on the chart is close to the i)ercentage in
column J. The chart will round numbers to the correct whole percent.

Click on cell Al {or anywhere on the spreadsheet) to de-select the chart.

Save, autoﬁt and pnnt with values. Switch to formulas, autofit again, and print.
Staple the two cppies together with values on top and place in your binder.



Sprzadsheet Problem #4

Problen; #4

Given the data below, create a spreadsheet that finds each student’s total points, each student’s percentage
grade, and presents a chart comparing the total points scored by each student. NOTE-—this asks you to
compare total points, not percentages. Therefore, it would be incotrect to use 2 pie chart for this problem!?

REMEMBER—PERCENTAGE IS FOUND BY DIVIDING THE PART BY THE WHOLE—IN THIS
CASE, YOU WILL NEED TO KNOW THE TOTAL POINTS EACH STUDENT HAS SCORED (THE
PART) AND THE TOTAL POSSIBLE POINTS (THE WHOLE)

Format the dota like you.did in problems 2-and 3. Remember to place a header on the document and print
the resulis—both values and formulas

Student Testl | Test2 | Test3 | Testd | Test5

Thomas 96 44 ] . 251 80
Richard 64 30 28 28 75
“Hamiet 95 45 34 48 05
Possible Points 100 50 20 30 00

Finding Percent
Charting

-






Spreadsheet Intermediate Lesson 1

Iritermediate Lesson 1—Function formulas
Cencepts:

Sum function formula
Average function formula
If function formula

Function formulas are pre-developed formulas that perform specific functions. The ones that we
will use are the Sum function (adds a series of cells), the Average function (adds a senes of cells
and divides by the number added to find the average), and the If function (tests a logical '
- comparison and refurns one value if it is true and a d:fferent value if it is false). This lesson will
use all three function formula. ' :

L. Create a spreadsheet with the following data:
Student Test1 | Test2 | Test 3 | Test4 | Test 5
Emma 96 90 45 35 89
Robert 95 91 46 38 69

Susan 64 76 28 26 67

Possiblc Points | 100 | 100 |50 |40 - |100"

2. Add an appfopriate header and save the document as Intennediate Lesson 1.

3. Add a column to find the total points for each student (row) using the Sum function key.
A. Click in cell GI, key in the label Total
B. Click in cell G2
C. Click the AutoSur Function tool on the toolbar—to the ri ight of the globe—
notice the computer automatically enters a formula desi gned to add the contents
of cells B2-F2. Click the enter check (green check mark}
D. COpy down the formula.

4. ‘Add a column to find each student’s percentage.

A. Click in cell H1 and key in the label Percent
B. Click in cell H2 and enter the formula to find Emma’s. percentage =G2/G6

- DO NOT ENTER YET!!!!
C. **%Tg copy this formula down—NOTE—this | process requires setting the divisor
(the second cell reference—G6) to an absolute. To do this click after the 6 in the entry bar
and press the F4 key. This function will place dollar signs in front of the G and in front
of the 6 making the divisor (G6) absolute—meaning it will never change——lt is absolute!
The end result should look like this: =G2/$G$6 :
D. Now enter this formula using the enter check {green check mark) and copy

down through the remainder of cells needed.

5. Find the average points scored on each test
Al Insert 2 rows before Possible Points (you will end up with 3 blank rows)
B. Click Cell A6 and key in the label Average
C. Click cell B6



Spreadsheet Intermediate Lesson 1

D. Enter the function formula to find the average of the three scores for Test 1
1. Click the down arrow to the right of the AutoSum function key
2. Click Average, look at the entry bar and make sure you have the correct

range of cells—in this case B2:B4, then press enter. (If you have an
incorrect range click in the entry bar and make the correction—you will
need to change BS to B4)

3. Press enter. The computer will return the average of the three numbers
which is 85.
,. E. Copy this formula into the next 4 cells
L Click on box in the tower right corner on cell B6 and drag through F6

F. Format the average scores to one decimal

l. Highlight row 6

2. Click format, click cells, click number, and set decimal places to one

6. Have the computer grade them Pass or Fail—The computer will place the word “pass” in

the cell to the right of the percentage if they pass or it will ptace the word “fail” in that
cell if they fail.
A. Click in cell I1 and key in the label Pass/Fail
B. Click in cell I2 and enter the formula to determine whether they pass or fail

I. Click the down arrow to the right of the AutoSum function key

2. Click more functions '

3. In the Insert Function box select the If function and click OK

4 On the window that appears find the Logical test box and place the test:

(If the student’s score is 68% or higher, he/she is passing. If the score is
below 68%, he/she is failing.) The logical test would be: H2>68%
Enter this in the Logical test box and press the tab key

5. The value if true should be pass, so in the value_if_true box, place the
word “pass” and press tab
6. The value if false should be fail, so in the value_if false bar, place the
word “fail” and click OK.
7. The formula in the formula bar should read =1F(H2>68%, pass”, fail")
8. Copy this formula down for all three students
7. Create a chart to compare student’s total points. (you may use any chart option)
8. Save and print two copies—one with values and one with formulas! Staple together and

place in your binder.

B

*k¥Be sure to print iandscape and click on fit to one page!



Intermediate Problem i
-

Intermediate Problem #1

Create a new spreadsheet called Intermediate Problem #1. Place anappropriate header on the document.
Enter the data listed below. Find the percentage score for each student. Find the average of each test score.
Have the computer print “pass”™ if they are passing or “fail” if they are failing. (Remember—passing is
anything 68% or higher.) Create a chart to compare the total scores of the four students. Save and pnnt_
Continue reading the directions afler the data when you have the first sheet printed.

Stadent’ Tost T | Test 2 Test3_ Testd [Tests

Ima Hogg -9 33 32 49 95
UraPige 88 3% 33 a5 59
Hesa Fool - T8} 24 Y 24 35 54
Shesa Rock 66 28 - 22 39 608
Possible Points 100 40 40 50 100

You have taken one more test and need to enter the data. Check your formulas to ensure that they are still
comrect—if not, correct them! Print two copies—one with values, one with formulas, and submit.

Additional data to be added
Student Test 6
Ima Hogg 95
Ura Pigg 2
Hesa Fool 98
Shesa Rock 100
Possible Points | 100

Funciion Formulas:

Sum
Average
if




Inizrmediate lesson 2

Intermediate lesson 2—Daia Manipulation

Concepts:
_ Enter data
Sort data
Filter data

One of the most powerful aspects of Excel 15 its ability to manipulate data. In this lesson, you have become
the secretary of the Mountain Park Athletic Club. It is your job to create a spreadsheet to keep track of the
followang information:

Member’s First Name
Member’s Last Name
Member’s ID

Member’s Street Address
Member’s City, State, and Zip .
Member’s Phone number
Member’s penmission status

1. Create a new spreadsheet and name it Intermediate lesson 2
2. Place an appropriate header on the document
3. Place the appropriate labels in row 1 (First name, Last name, etc.)
4, Enter the data found on the Mountain Park Total! Membership Info sheet
5. Auto Fit the result, save and print
6. Sort the data
A. Highlight all the data except the labels in row 1
B. Click on Data
C.  Click on Sort
D Chick on the Sort by option and find last name
E. Be sure you have ascending checked
E. Click OK
G.  Save and print
7. Filter the data so that only those with permission show
A. Highlight all the data
B. Click the Data menu option
C. Click Filter
D. Chick AutoFilter—Notice—an arrow will appear in each column
E.  Click on the arrow in the Permussion Field
F.  Click on the 0—mnotice, the other options will disappear
(. Save and Print
H. Click on the arrow again and select All to return all the records to the screen
L Save



FirstName
Darlene
Donald
Valerie -
Tomoyuki
‘Donna
David
Donna
Damon

Mountain Park Athletic Club Membership List

LastName
Rhodes
Rase
Matthew
Matsunaga
Link
Jefferson
Davis
Crosby

id
3167
8124
3311
3321
3611
8795
4522
2145

Data for Inte

Address]l

1070 Mahogany Ave.
5862 Terra Grove Rd.
4128 E. Arborwood Dr.
777 Candlegreen Cir
1755 McComack

366 Oakland Park

5028 Cartergrove

8027 Trimmer Rd.

.« Lesson #2

City
San Diego
San Diego
San Diego
San Diego
San Diego
San Diego
San Diego
San Diego

State
CA
CA
CA
CA
CA
CA
CA
CA

PostalCode
92167-1135
92166-6391
92166--4693
92166-8156
92167-8233
92166-9643
92166-2169
92167-8731

HomePhone
332-5121
456-3412
322-1245
452-4367
45541333
275-1244
322-4567
452-8867

perm
1

— Yy = = = O (O



sietmediate problem 2

Intermediate problem 2

Create a new spreadsheet to perform the following functions

1.

Enter and save the given data. Autofit the data, set to print centered horizontailf with grid lines
showing and row and coluna headers showing. Print.
Sort the data alphabetically by last pame and print

2
3. Filter the data to print only those who live in South Dakota and print
4. Staple the three printed copies together and hand in.

First Name

Address

Last Name City State | Zip Grade
Thomas Becket 1234581 | Watertown | SD 57201 | .88
Richard Lionticart 234 5% St { Watcrown | SD 57201 |76
Hamiet Stowe 3456 St. | Watertown | NY 18002 | .55
Jo Mamakpows | 456 70 St. | Watertown | MN  { 56345 | 67
Annette Forfish 567 8°St. | Watertown | SD 57201 | 98
Bill Melater 678955t | Watestown | VE 2341 .86

Chalienge: Filter the spreadsheet so that only those students who are not passing (a score lower than 60%)
appear on the spreadsheet. Explain in writing how you performed the filter.




Excel Assessment

You are working for Wal-mart, and have been placed in charge of the camera division. Your boss has
asked you to track the sales of five cameras. She wants to know the number of each camera you sell each
week, the tolal number of cameras sold, the total money raised from each camera, the total money raised
from all cameras, and what percent of the total of al) dolar sales each camera’s total is. Likewise, she
wants to know the average number of cameras sold each day! To help her understand sales patterns, she
also wants to see two different charis—a chart that compares the sales by number sold and a chart that

compares the sales by dollars sold. Smce you are ready for your 6 month evalvation, you want to make the -

spreadsheet attractive and easy to read. You will receive an extra point for placing a merge and center title
on the sheet. Remember to format the spreadsheet correctly, include both values and formulas, be sure
neither printed copy is fonger than one page, staple and hand in at the end of the hour.

Data:

Cameras Cost Monday Tuesday Wednesday Thursday  Friday Saturday
Canon Sureshot 3129.95 3 2 0 3 2 1
Yashika One Step $195.95 2 3 2 1 1 2
Polaroid One Step $49.95 3 5 8 9 2 1
Canon Alph $199.95 1 3 2 1 1] 1
Kodak Instamatic $33.95 ] 2 3 4 5 6

To help you be sure that everything is done, use the checklist below.

0 Create a new spreadsheet named Spreadshéet Assessinent
L} place an appropnate header on the document

D Enter the data

D Find the total number of each type of camera sold
U Find the total number of cameras sold

D Find the total money raised by each camera

2 Find the total money raised by all cameras

0 Find the percent of total dollar sales each camera is
O Find the average number of cameras sotd each day
Q Chart the companson of total numbers

U Chart the comparison of total money

L_..I Format and print a value sheet

O Formal and print a formuta sheet

T



Excel Enrichment #1

Ezbz Inc. sells five different flavors of fudge for $5.00 a batch. They have hired you to
do their inventory. Each day this week they have kept track of how many of each type of
fudge they have sold. Your job is to find the total number of each type of tudge sold for
the week, the total number of orders for the week, and the amount of money that should
have been collected. bz, their boss, also wants to know the average number of orders
sold per day and the % of total orders each flavor makes up. bz 1s a visual person. so has
also asked that you create a chart that will compare the total number of orders sold by
flavor. PRINT WITH VALUES AND FORMULAS AT THIS TIME! Finallv, he
wants the dala sorted alphabetically by flavor type (PRINT AGAIN) and filtered so that
any flavor not selling at feast 20 orders is PRINTed out. Being persnickety, bz also

wants the printouts to be attractively formatted, with grid lines showing and the data
centered horizontally on the page. '

Chatlenge—bz wants the computer o place an smiley {: )] nex. to all batches of fudge
that make over $75.00 for the week, and a frown {: (J next to it that don’t. Use an if
function formula to do it! PRINT 2 more copies—one with valhes and one with

formulas,

You will have six PRINTED copies to turn in—the onginal valu s and tormulas (2). the
alphabetical sort (1), the fiiter (1), and the values and formulas of the chadlenge (2).

DATA
: Monday Tuesday Wednesday | Thursday | Friday
t Chocolate 12 33 22 12. - 10
, Vanilla 4 3 2 !
' Peanut Butter 13 23 i2 B! {
i Almond i 2 4 5
{ Peppermint 2 13 2 0 I |







Excel Enrichment #2

The problem—Having just been hired by Christmas-R-Us, a local holiday decorating store, your boss has looked at your resume and
found that you are computer literate. To help grow her business, she has decided that she wants weekly reports on how well her
salespeople are doing in each department. As department chair of the novelty light section of the store, you have six employees
working for you, Each day, the cash register prints out how many of each item in stock each employee has sold. At the end of the
week, the computer will print out a total of sales for each employee,

The solution—Design a spreadsheet that takes the weekly data and finds the total amount of money raised by each employee, Then,
the spreadsheet should find the percent of total sales each employee brought in. To compare sales by employee, you will need to
create a pie chart comparing weekly sales. Your boss has also asked you to find the average number of each type of light sold during
the week. Finally, she has asked to print whether the salesperson deserves a bonus or not (to earn a bonus, the employee must have
sold more than a total of $350.00 worth of products during the week.) Have the computer automatically print “Bonus” or “No
Bonus”, For your records, be sure to print a report (formatted correctly) that contains the mathematical resuits and a report that
contains the formulas used to find those results. To make the report complete, the boss wants a printed copy of the data organized
alphabetically by last name, and a separate report listing only those who should receive a bonus.

The bonus—1If all data and results are correct, you can receive up 1o 5 extra points for demonstrating your talent at formatting—make
the reports “attractive” and get the extra points!

Weekly Data

Salesperson® Bl-colored Lights Pooh Lights Candle Lights M&M lights Chiit Pepper Lights
$3.95 $12.95 $9.95 $6.95 $14.95

Thomas Richards 21 7 12 15 3
Richard Harriet 12 5 15 _ 12 5
Harrlgt Thomas 18 <] 13 3 i
Igot Lotsados 13 & g 5 0
I. M. Poor 10 2 8 4 1
I. Cudcareless 3 9 5 19 5

* Be careful when you enter this data—note the need to alphabetize!






Excel Enrichment #3

~You have just been appointed the supervisor of the green plants division of ezbz floral.
Your inventory includes tomatoes, green peppers, red peppers, yetlow peppers, cabbage,
parsley, and squash plants. At the end of each week you must make the following report:

Skill to demonstrate Possible | Points
: Points | Awarded
t | Total number of each kind of plant sold during the week 5
2 | Total money raised by each kind of plant 5
3 | Total number of plants sold 5
4 | Total money raised by selling alf plants 5
5 | The percentage each weekly sale of plants is of the total 5
weekly sales

6 | The average number of plants sold per day. 5
7

To help your employer understand which plants are selfing
best, create a chart that compares the total number of each
type of plant sold. Be sure to label the data so that the chart is
-eastly understood

8 { Estabhsh a filter that shows which plants sold more than 100

units for the week and print one more sheet with the vatues 10
and filtered data showing.

10

After finishing skills 1-7, print the information using the page-setup directions we have
used 1n this unit (remember—all data must be printed on one page). Be sure to print one
sheet of values and one sheet of formulas. Complete the assignment by doing the filter in
skill 8 and print a third sheet with the values showing. Turn in all 3 sheets.

Your sales personnet have tumed in the following data

Tomatoes Green Red Yellow Cabbage Parsley | Squash
$3.59 Peppers Peppers Peppers $1.59 $.89 $1.49
$1.99 $2.19 $2.39

M--25 M—12 M—5 M—15 M—28 M—33 M—2
T—22 T—35 7 T—14 T—33 T—44 T—3
W—33 W--27 W—3 W—I13 W—34 W-—-55 W—4
Th—32 Th—12 Th—18 Th—12 Th—44 Th—66 Th—14
F—1i5 F—I15 F—12 F—11 F—22 F—22 F—15
S5—55 S—33 S—15 S—23 5—55 S—I11 S—54

Optional Challenge—Counts as an enrichment.

Add a formula that checks the total number of plants sold and if under 100, prints the

word enough, and if 100 or over, prints the word reorder. Tu

values and formulas.

m in a printed copy of







PUBLISHER

Publisher problem:

You have just accepted a position as Key Club Advisor for Watertown Senior High
School. As advisor, you are responsible for encouraging membership, planning the
spring banquet, and awarding certificates of excellence to your outstanding members,
Likewise, you will be traveling to the national Key Club convention, so you wili need
business cards to take with you. Keep the three printed projects in your possession until
you are finished. (you do not print the certificates)

Job #1—Create a flyer announcing a Key Club meeting to be held at 3:45 on Friday,
May 19, 2006, in room 304. The announcement should be on one full sheet and must
contain the key club logo. Key in your name on the bottom of the flyer. Print.

Suggestions to solve: o

1.  Using Google, search images for the Key Club logo. Save the picture as
KCLogo to your folder. :

2. - Open Publisher and click the blank publication option.

3. Place the logo on the page, enlarge it and format the picture “shade” or
“washout” the logo to use it as a watermark.

4. Place the pertinent text and any other graphics you may want to use on the

flyer. (sce the example) _

5. Place a border around the edge (select the Line/Border style tool).

6. Use the F9 key to toggle from the small view to full size and back to small
size.

7. Remember to place your name on the flyer. Print.

Job #2-—Design a “four page” program for the awards banquet to be held May 25,
2006. The banquet is going to be held at Past Times and will begin at 7:00. The program
for the evening will include an invocation by the principal, dinner, a presentation by Dr.
Robert Mayer entitled “Pay-back Time”, and presentation of awards. The menu for the
evening will be Prime Rib Sandwich, Cheesy hash browns, tossed salad, sweet and sour
green beans, and individual cheesecakes for dessert. The last page must contain the Key
Club logo and the list of officers: {Your Name], President, Ura Pigg, Vice President, Ima
Hogg, Secretary, and Igot Bucks as Treasurer. Board members include: Count Me-in,
Hook Aires, and Betty Wont. Print one copy front to back (this will require you to
manually feed the document, turn it over, and print on the other side!).

Suggestions to solve:
i Use the program wizard in Publisher.

2. Remove all existing text and graphics.

3. Place the event name, date, time and location on the cover; use a border

4, Place the program (with menu) on page 2.

5. Copy and paste the Key Club information on page 3—this information is
found toward the end of: http://www.keyclub.org/keyclub/about/history/

0. Place the logo, officers, and board members on page 4.

7. Use the example provided for guidance and print when done.



Job #3— Design a certificate of achievement for Community Service and present it to
the honorees (they are listed on the sample program in the binder materials). When
finished, call your instructor.over to your computer tograde this document from the
screen

Suggestions to solve
1. Use the Award Ceitificate w1zard in Publisher.

- 2. Change the data so that it is consistent with the award (see the example
provided). Place your name on the signature line.
3. Create a mail merge document

Highlight the name blank on the certificate

Go to mail merge and create an address list

Delete all fields but first and last name

Add names (they are on the sample program)

Insert fields into Name box

Show merge results
Remember to call the mstructor to your computer for the certificates to be
graded.

Job #4—Design business cards for yourself as the Key Club Advisor for Watertown.
Print on plain paper—several tiled to a page.

Suggestions to solve:

Use the business card wizard in Publisher. (use example)

Update existing personal information (change it so it is appropriate for you)
Be sure to tile several to a page.

Delete the existing logo and replace with the Key Club logo

Mantipulate the card so it is attractively formatted.

Print on plain paper.

R R

At this time, collect the three printed copies, staple them in the order in
which they were produced, and place them in the hand-in binder.



[N o T, T A, T, T, T Sy TR S S, Sy e g e g, S S S T, S T A S S S T AT T, i SR S S S, T A TR A T W s T T A )
]

n

[

P e

ey Club Meet

ted by Your Name

Créa

Flyer

N

o

o o e B i

o

L3

W= e T

L
73

e

T .-._’?o

e

e

ﬂ;»%,[ll.e%”laﬂ”:ﬂﬂfm,ltl‘.lhni”&“ﬁ”&&ﬂ%ﬂ%“@“&”&"ﬂ”ﬁ A e W O o WP o e e 28, e AP § o e e 8 =M, 3 o= e i e O e e W e P e W = A =Y )

TP S SRSt ST

=5




o MIMA g

‘9W09 0} S1eaA Auew Jo) sodumg qreg
Umolb Ayjeay ‘Apes)s e joadxe ued sqnid 19 Auuuo
A8)| ‘epinb & se uousIo SIL YIAA "UoNs se N 4 h
SlaquuNU a1awW Uo Ueyj) Jayjed ‘sqnjo aAijoe o&@gum Axen’
‘“wsueultad uo si siseydwse nq ‘uoneziueb

-10 BuImoib 158} SIU} 0} peppe 8Je sqniD) A8y sodwe)) £pparg
MU 8I0UL JO PaIpUNL OM] ‘SISOIIO [euo) sesorddy epurppg
-eulalul sy} AQ-pe| ‘esA Ataag ‘Buisiwoid s . |
ymosB ainny pue ueaqque) suj Ul pauwloy .TE_@G INOA| Spresy

usaq 0s[e oAl SAN|D A9y peppe ussq
aABY 8J0W AuBw 3w JBY) 8oUlS pue ‘epe

-Ued ul jing sem qnjo isdlf Uy 961 Uj "uon . (U, Momm-bwms
-eziuebio Jjeuoneuisiuj, ue _»__:.a S os_o Aoy )

__ 34BN I UOTIBITISIIJ
R .mEmBm arendoidde
UM _m:vs_vg 10 sgnjo jo aolnses Buipue)s
-Ino 8zjubosel 0) pue ,mcﬁn_:_o AS¥ UG AHBIISDD
seap) abueyoxe 0} ‘sgnio [ENPIAIPUL JO SLOYS A 1O
9U} 8)BUIPI00S 0] ‘dISMO]|9} 10) SUOHRUBAUOD sueaq U2213 INO0G /1998
[enuuR UMO 1Y) pioy suoneziueblo ssey]
‘SjoLIsIp sluemiy| Juesed s pue pusIq | PE[ES PosSOL
epuolq [eulbLo syy Jeye psuisped s| uoy SUMOIQ [sey %ooﬂu
-eziueblo 1usIq gnio Asy oy "edInIes pue |
diystepes| ul Buiuies Buiaiooas sle sjuepn)s oIApPUES iy dSWiId
Jo spuesnoy; ‘sdnouf asauy} U] ‘eale uesq
-que) au pue esuawly YUON inoybnoayy PRUTI(J
paes0] sgn|2 Mmou ate alayy ‘Apides molb
01 SaNUUOD N A8 ‘SZ6L JO A 20uIS
PP TN UOnNEI0AU]

- gopewrojul qup) 493 0 werdord



% ZE 2% B 3 2% 2% 4 4 % 34 24 2% 35 3L X8 X0 502 2E AL A AL AN N

1onbueg

w@H®B<
ooom mooN
ue EM

AR R AR R R AR R R R R R AR R B AR R A e R R R AR R e R B R B G R B S B E S B B

FZEXEZ | 5AX0ZEXAZRAENEES R NAIA LS IR AL AR ACAAIAAS

&%%#ﬁ%ﬁ%#%&%ﬁ%%%%ﬂ%%%%%ﬁﬁﬁﬁﬁ%%ﬁ&%%%%%ﬁ%&%&ﬁﬂ%%

1goM £19g
SOITY JOOH
UT-9JA] 1UnON)
SR pTEoq
JoImseaIy, syong 103
 Azwpomog 380y ey |

TUAPISATJ 2ITA 331 eIn
1UOPTSAI] dWEN INOX

SINIO) qnI)) 493 UMOIIIBAN




OL Q31N253¥d S| 3LVI1411330 SIHI




[Your Name]
Advisor

Watertown Senior High Key Club

200 9th 5t. NE
Box 730
Watertown, SO 57201

Phone: 605-882-6316
Fax: 605-882-6327
Ernail: wsernamei@wtn ki2.sd.us

Fax: 605-882-6327

[Your Name]
Advisor

Watertown Senior High Key Club

200 9th 5t NE
Box 730
Watertown, SO 57200

Phone: 605-882-6316
Fax: 605-882-8327 .
Ermail: usemamei@win k] Lsdus

[Your Name]
Advisor

Watertown Senior High Key Club

200 Sth S5t NE
Box 730
Watertown, SO 57201

Phane: 605-882-6316
Fax: 605-882-6327
Ennail: wsermame@winkl 2.cdus

[Your Name]
Advisor

Watertown Senior High Key Club

200 9th St. NE
Box 730
Watertown, $D 5720)

Phone: 605-982-6316
Fax: 605-282-6327
Emrail; wsername@wink 12 sd.us

[Your Name]
Advisor

Watertown Senior High Key Club

200 9th St NE
Box 730
Watertown, SD 57201

Phone: 605-882-6315
Fae 605-882-6277
Erviail; username@winklZsd.us

[Your Name]
Advisor

Watertown Senior High Key_ Club

200 %h 5t. NE

Box 730
Watertown, SB 57201

Phone: 605-882-6316

Email: username@wink L sdus ’

[Your Name]
Advisor

Watertown Senior High Key Club

200 9th 5t. NE
Box 730
Watertown, SO 57201

Phone: 605-882-6316
Fax 605-882-6327
Email: username@wn.biil sd.us

[Your Name]
Advisor

Watertown Senior High Key Club

200 9th St NE
Box 730
Whtertown, SD 57201

Phone: 605-882-63E6
Faxc 605-882-6327
Ermail: ssername@win. b Lsdus

[Your Name]
Advisor

Watertown Senior High Key Club

00 Hh S ME
Box 730
Watertown, SO 57201

Phone: 605-882-6316
Fax: 605-882-6327
Email: usermame@win.kl2 sdus

[Your Mame]
Advisor

Watertown Senior High Key Club

200 9th St NE
Box 730
Watertown, SD 57201

Phone: 605-882-6314
Fax: 605-862-6327
Emait: username@winksdus




L Fob S gu #page for the Key Club scrapbook hnglﬂ-ghhng your r activities ind

e i Pubhsher Ennchment

responsibilities-as advisor and presndent for the organization. The page shiould inclhude : at o
Jeast 4 graphics—digital camera images. Include borders and labels. These pages may
' be dlsplayed for pablic vlewmg. S

*"».'. .
ST

177+ " Use the blank pubhcatlon document.
2, Inchude a border around the edge of the page
. °73.  ‘Bordéreach of the plctures (be creatlve and fill dlﬁ'crcnl shapes with
- -piciires)
4.  Includea t;tle for the page.
5. Labekgach picture.
6.  Includethe Key Club logo.
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Washington DC

My family in Wasbington DC
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The
Fmal
PPOJ@CT

 Introduction to Computer

- Edc_h"sfudenfmu:s’r."pr'ésen’r 'a_fihal pr"b'j_'ecf_:'_' -

s The pro;ec'r will demonsfmte mastery of each of the sof twares 'I’augh? inclss. .
« The project moy be done individually or with a' par'fner' "NO MORE than two people
_may ‘work on any one: project. If done with a partner, each person Wt“ receive 1he '
- . same grade. Each person must be an active. participant.
-« The project is presentational in nature.- The presenter's must be dressad
: appropriately for the project. U
- = The project will count for apprommofely 10% of the fmal grade. If mastery isnot
“demonstrated during the software unit in class, it may be demonstrated here.
 Failure to present the final project will result in an incomplete grade which will turn
to.an F for the grading period if the presentation is not given.



" | 'fhe J'ob‘-

 Based on the fo//owmg assvmpﬂon.s'—ﬂ?e sfudenr is 13 years of age |
_ has been emancipated, and has no other means of support. He/she -
must find a Jobff Use fhe soffwares in ﬂ:e fa//owmg manner:

: WORD (word processmg) A merge. document wall be crea’red asklng for mformahon o

-concerning the possabah'ry of employment, gives the author's qualifications, and uses a table -

to provide a return address and contact information about the future employee The

three paragraph letter must be done.in block style The letter must have a header with

* the author's name. A printed copy of the unmerged !eh‘er is r'equzred as well as. coples of
_’rhe resuh‘ of the merge, all sagned inink. :

_ACCESS (da’rabase) Comp:le a database fable of 10 local busmesses mcludmg The
manager's first name and last name, name of the business, address (this includes city,

' state and zip code too) of the business, the business phone number, and type of business -
(ser*wce or producf) ‘The database will be sorted alphabe’rlcally by the manager’s last
name and filtered for alist of product providers.and a list of service prowders The

~_student's name must appear on the list with an asterisk precedlng the- Iast name for a total .

of 11 em‘r'les Prmtouts of the sorted and f:lfered copres are r'equwed

" EXCEL (spr'eadsheet) Cr'ea’re a workable reahshc monthly budget that allows ’rhe student
- to survive on his/her own, A monthly total must be found along with the percent of total -

each area isand a graph comparing the total spenf on each area of the budget. Formaﬂed ' o

. copies of the values and the formulas used 10 reach those values mus‘r be: pmn’red A
header' must be used to tdem‘lfy the aufhar' T : C

. 'FRONTPAGE Creafe a personal web page (non—publlshed) wh:ch wul! mciude both |m‘ernal _
"and external links to describe the s’rudem The student’s picture must appear on the web
page and the page must be at’rr‘ac’nve in appearance and easy to navsgate Prmt HTML and _

. normal vuews

- PUBLISHER (deskfop publlshang) Crea’re a workmg resume whlch mcludes a plc?ure of the :
. au’rhor and other mfor’ma'r:on necessary To apply for' a JOb :

POWERPOINT Desugn a slide show of mmlmally fwe slrdes to sappar’r the 'pr'es'en'ia'ﬁ'an of .
- the choser project.” The slides must each demonstrate use of background; text, graphics, -
" custom animation, and-slide transitions befween the slldes Two daffer‘ent pr'mTouis are

o requ:r‘ed of the sfudenf _



The Men’u ..

Based on ﬁre fa//amry assumptions—rthe 5'fua’enf s emp/a yed b y _
EZBZ Printing Company and i s aﬁemprm_q to get local restaurants to
- order menus from ﬂll.S' compary. Use the saffwares in ﬁze fo//owmg

manner:

WORD (word pr'ocessmg) A merge documem will be crea?ed which ln’rr'oduces ’rhe. |
salesperson (you) and the printing company, explams why he/she is wr'mng the letter, and
asks for the restaurant’s business. The Ie’rTer‘ uses a table to provide a return address -
and contact information about the sales person and the business. The three paragraph
‘letter must be done in block style. The letter must have a header with the author's name.
A printed copy of the unmerged Iet’rer' is reqwred as. we!l as copses of the result of the
_ merge all szgned in ik, ' : :

ACCESS (database) Compile a database table of 10 local restaurants including the =~
~ manager's first name and last name, name of the restaurant; address (this includes city,

~ state and zip code too) of the restaurant, the phone number, and type of restaurant
(elegan't or famlly) The database. will be sor’red alphabeflcally by the ‘manager’s lasf name
and filtered for alist of elegant restaurants and a list of family restaurants. The '
- student’s name must appear on the list with an as'remsk preceding fhe last name for a ’rofal

. of 11 entries. Printouts of the sor’red and f |I?ered coples are requwe.d

EXCEL (spr'eadsheet) The si‘udem‘ will select fwe items that will appear on. The sample
menu. For each item the s?udem‘ will find the bulk cost, mcllwdual serving cost, the .
overhead cost, and a profit cost. A. chart will be prepared comparing the five items,
R For'maﬂed copies of the values and the formulas used 1o reach Those values must be _
 printed. A header must be used to |denhfy fhe author, :

" FRONTPAGE: Create a web page (non-publrshed) for EZBZ Pr'mtmg which explcuns your

business. Include both internal and external links. Graphics must be included along with
an exarnple of your sample menu. The page rnust be aﬁrac‘rwe m appearunce cmd easy to '
nawga’re Pr'm’r HTML and normal views, : c

_ PUBLISHER (desk'rop pubhshmg) Creafe a sample menu whlch includes (but is not I:rm’red
10) the fnve items on the spreadsheet descriptions of the items, and gmphncs to rnake it

o _ -_'.aﬁrach\re The f:nul copy should be prlm‘ed on boTh sndes and folde.d appropmafcly

o POWERPOINT Desugn a sllde show of mmlmally five slldes to suppor"r the pr‘eseniaﬂon of -

the chosen pro ject. The slides must each demonstrate use of background, text, graphics,*

" custom animation, and sltde transitions between fhe shdes Two dlffer'en’r pr'mfouts are -
r‘equu‘ed of ?he s?udent ' - : :



| The Weddmg

Based on fhe fa//amfg assumpnons——e: ‘ther the sfudenr s
_ geﬁm_g married and has to plan the event or the Sfua‘enf will
serve as a wedding planner and p/an a weddmg faf' someane
Use fhe .s'affwaf’es n fhe fa//owmg manner: '

' 'WORD {word pr'ocessmg) A merge. documen’r will be created wh;ch mvn‘es gues*s ’ro a
wedding shower; explains the type of shower, and uses a table to provide contact
information for the RSVP. The three pamgmph letter must be done inblock sfyle The '
letter must have a header with the author's name. A printed copy of the unrnerged leﬂer' -
s reqmred as well as coples of the resul‘f of ’rhe rner'ge. al! sagned in mk '

'--ACCESS (da’rabase) Compu!e a dafabase. table of 10 weddmg gues’ts mcludmg ‘rhelr f:rsf ._ : _

*name ond last name, address (this includes city, state and zip code t00) of the guest, the

_phone number for each guest, and classification as fo whether the guest isa friend of the
~ bride or groom. The database will be sorted alphcbe’ncally by last name and filtered for a
_ list of the bride’s friends and a Ilst of the groom'’s fmends The students name. mus'r o
- _appear on the list with an asterisk precedmg the last name for' a Tofal of n em‘rles -
'Prmtoufs of the sor?ed and flh‘ered cop:es are requwed :

.'EXCEL (spreadsheet) Crem‘e a workable reahshc budge’r covemng 1he. expenses of a

- wedding from the engagement to the honeymoon. Bivide the expenses into three .

ca?egomes-pre -wedding, wedding, and post-weddmg Total expenses must be found for

~ each area as well as the entire wedding. Find what percent of the foTal expenses each -

area’is. A char-f will be. prepared comparing the three: expense areas. Formatted: copies of_ -
. the values and the formulas used to reach Those valuas must be prmfed A header must be
. used to lden’nfy 1he au’rhor' _' - : : : - '

- FRONTPAGE Cr'ea're a web page (non-publlshe.d) to ussns? future brndes and grooms Wlﬂl
their wedding plans It must include a picture of the couple gethng married along with the
- . wedding information. Include both internal and external links. Graphlcs should be included
" asneeded. The page must be’ aﬁmciwe in appeamnce and easy To navigate. Print HTML .
- and norrnal views, _ _ . :

_\_PUBLISHER (desk’rop publashmg) Crea're a weddmg progmm to-be handed out’ pmor to 1hé .
- wedding ceremony. The program must inchide a picture of the br-:de and groom. Enhance '
~ “the looks of the. document with gr'aphlcs different font styles and snzes The fmal

: _product shou!d be prnm‘ed on both sndes nnd folded appr‘opnafeiy | IR

' POWERPOINT De&gn a shde. show of mm:mally fwe sildes to support the presenta’rnon o‘f_' B

~the chosen prOJecf The slides must each demonstrate use of background text, gr‘aphlcs
- custom animation, and slide fransitions be‘l'ween 1he shdes Two dlfferen’f prmtouts are
_requnred of the studen’r I : _ _



The Teacher

Based on the following assumptions—you teach a class of 21
students who have just finished the word processing unit. You are
to find the student’s percentages and inform their parents of
their progress. Use the softwares in the following manner:

WORD (word processing): A merge document will be created to send to the students’
parents inforfing them of their student’s grade and inviting them to conferences. A table
should be included providing information.about how to reach the teacher. The three
paragraph letter must be done in block style. The letter must have a header with the
author's name. A printed copy of the unmerged letter is r'equsred as well as copies of the
result of the merge, all S|gned in ink.

ACCESS (databose): ‘Create a database table that contains your students and their
parents. Include their first name and last name, parent’s name and title, address (this
includes city, state and zip code o0}, and the student’s percehtage. The database will be
sorted alphabetically by the student’s last name and filtered for a list of all the students.
who have A’s, the student’s who have B’s, the student’s who have C's, D's and those who are
failing. (This will require five different filters) The student’s name must appear on the
list with an asterisk preceding the last name for a total of 11 entries. Printouts of The
sorted and fnlfered coples are required.

_EXCEL (spreodsheef) Create a spreadshee’r that calcu!a?es each student’s $otal po:m‘s
- the total points possible, the average score for each problem, and each student’s
percentage. Prepare a chart comparing each student’s total points. Formatted copies of
the valiies and the formulas used to reach those values must be printed. Print a list of
students not turning in problems 1, 2, 3, 4, or 5, and print a list of students whose :
percentage is below 85%. A header must be used to identify the author.

FRONTPAGE: CreaTe aweb page (non published) about your school. Include pncfures of
your school, an explanation of your class, pictures of. your classroom, samples of some of
the assignments, and links to any educational websites you think parents would be
interested in viewing. Include both internal and external links. The page must be
attractive in appearance and easy to navigate. Print-HTML and normal views.

" PUBLISHER (desktop publishing): Create a certificate of completion to give to each
student who has 85% or better in word processing. Print one certificate for each student.
who meets the requirement. Enhance the looks of the document with graphics, different
fon‘r styles and sizes.

POWERPOINT: Design a slide show of minimally five slides to support the presentation of
the chosen project. The slides must each demonstrate use of background, text, graphics, .
custom animation, and slide transitions be'rween the slides. Two different pmn’rom‘s are

- required of the student. :



The Rec:pe Book

Based on the following assumptions—the student is going to
create a recipe book containing the favorite recipes of local .
politicians, teachers, or relatives. (At /eas'f two of the three must be used) Use
the softwares in the fo//awm_q manner: -

WORD (word processmg) A merge docurnem‘ will be created explammg 1he. project to the
recipient, asking the person for their favorite recipe to be returned via e or snail mail, and
uses a table to provide the email or snail mail addresses o which the recipe can be sent,
The three paragraph Jetter must be done in block style. The letter must have a header
with the author's name. A prmted copy of the unmerged letter is required, as well as
copies of the result of ’rhe rnerge all signed in ink. These letters wﬂl ac’rually be sent to '
the reaplen'r o : :

ACCESS (daiabase) Compzle a da’rabase Table af the 10 local pohhcuans 1eacher's or
. relatives you have selected. The database must include the first name and last name,
address (this includes city, state and zip code Yoo), and classification as fo whether 'fhey
are a politician, teacher, or relative.  The database will be sorted alphabetically by the -
* person’s last name and filtered for a list of politicians, a list of teachers, and a list of
relatives. The student’s name must appear on the list with an asfensk precedmg the last
name for a tofal of 11 entrles Pmn’rou‘rs of 'fhe sorted and fllfered caples are requlr'ed

EXCEL (3preadsheet) Select at least 'rwo of the recipes and analyze. them by fat con’rent o

or calorie content. Find the percent of the total fat or calorie content each mgredlem‘ is.
Make a graph comparing the total fat or calorie content, Formaﬂed copies of the values
and the formulas used To reach those values musT be printed. A header must be used to

. |dent|fy the au’rhor‘ :

- FRONTPAGE: Create a web page (non—publlshed) centered on cookmg At Ieas'r two of the -
recipes must be included on the web page as well as links to other sources of re.cnpe,s on

the web. Include both internal and external links. The student’s picture must appearon
the web page and the page must be aﬁrac’ﬂ ve in appearance and easy ‘o navigate.. Prmt
HTML and nor'mal views. :

PUBLISHER (deskfap pubhshlng) Create a recipe book which includes al 10 recnpcs and
'rhelr' authors. Aﬁrachvely format the book!eT using graphics and two-sided pmnhng

POWERPOINT Design a shde show of minimally five slides o support the presemahon of
~‘the chosen project. The slides must each demonstrate use of background, text, graphics,
custom ahimation, and slide 'rransmons between the slldes Two dtfferen't pmm‘ou'rs are
. .reqmr'ed of the student.. : : : L :
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